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Overview (Customer Insights)
The Customer Insights Accelerator is one of many pre-built solutions from Pricefx that provides a 
customer with a quicker path to the analysis of their pricing data.

Pricefx Key Accelerators

You can also watch a video introducing Customer Insights and its usage:

In this section:
Business Overview (Customer Insights)
Accelerator Solution (Customer Insights)
Value Measurement (Customer Insights)
KPI Metrics (Customer Insights)
Capabilities Summary (Customer Insights)
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Business Overview (Customer Insights)

Premise

You are involved with the review of customer and product analytics, and trend analysis as part of a team 
from either Pricing, Financial, Sales, or IT support within your organization.

Desired Outcome

You need to prevent margin leakages through a set of actionable analytics for sales and pricing enabling 
identification of customers at risk (with low health scores) and reasons behind. It includes advanced 
analysis of the performance of all customers, individual customers/customer groups as well 
product performance for a customer.

Context and Background

After loading the product, customer, and transactional history into Pricefx and creating a Datamart, you 
are ready to start analyzing sales and pricing information for your customers and products. You need to 
examine each of them to identify which ones are performing poorly and understand the reasons for this 
poor performance.

Problem

You recognize that not all customers or products are providing healthy contributions to your gross margin 
and you need to apply an analytics tool that will correctly identify those that are performing poorly and 
clarify the root cause.

Solution Capabilities

Once this accelerator has been implemented and linked to your Datamart, then these analytical 
capabilities will be available:

Ability to health score for customers and products
Provide insights on revenue and margin trends
Identify the top and bottom performing customers or products
Highlight pricing and sales opportunities

Accelerator Solution (Customer Insights)

Accelerate Customer Insights Package allows management teams to prevent margin leakages through a 
set of actionable analytics for sales and pricing enabling identification of customers at risk (with low 
health score) and reasons behind.

It includes advanced analysis of performance of all customers, individual customers / customer groups as 
well product performance for a customer.

KPIs provided by the analysis:

Customer and Product health scores
Revenue, Margin and Volume trends
Pricing and Sales opportunities
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Value Measurement (Customer Insights)

This accelerator is designed to provide an overview of the trading performance of different customer 
groups through a series of dashboards. These are the measurements they provide:

Global View – Provides customer performance via health score and revenue, pricing and selling 
opportunity, and overall customer summary.
Detail View – Provides a detailed customer view on revenue and margin, waterfall chart, high/low 
volume products, and revenue and margin trends.
Customer Products Portfolio – Provides pricing opportunities by product type or attribute, identifies the 
top and bottom products.

 Each of these different dashboards integrates our KPIs and allows you to measure them across one or 
more dimensions:

Health Score
Date (Yr, Qtr, and Month)
Customer ID
Product ID
Product Class
Product Group
Product attribute

KPI Metrics (Customer Insights)

KPI stands for key performance indicator, a quantifiable measure of performance over time for a specific 
objective. KPIs provide targets for teams to shoot for, milestones to gauge progress, and insights that 
help people across the organization make better decisions.

KPI vs. Metrics

While key performance indicators and metrics are related, they are not the same. Here is a quick 
explanation:

Our definition of KPIs is the  you should be tracking  on your key targets to make the biggest impact
strategic business outcomes. These KPIs will support your strategy and help your teams focus on what 
is important. For example, a key performance indicator could be targeted new consumers by month.
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Metrics, on the other hand, will measure the success of  that everyday business activities support your 
. While they may have an impact on your outcomes, they are not the most critical identified KPIs

measurements. Examples could include monthly site visits or number of modules installed.

Customer Insights KPI

As the name implies, the goal here is to examine customers and that is performed on three different 
levels: global view, detailed customer view, and customer/product portfolio. The key KPIs being analyzed 
are:

Revenue
Margin
Volume
Health Score

Capabilities Summary (Customer Insights)

Out of the Box

Global View dashboard, with charts and table reports:
Customers Performance by Health Score
Customers Performance by Revenue
Customer Health Summary
Trends
Pricing Opportunity
Selling Opportunity
Customer Summary
Inactive Customers

Customer Detail View dashboard, with charts and table reports:
Specialty and Commodity Products
High Volume and Low Volume Products
Revenue and Margin chart
Waterfall chart
Revenue Breakdown chart
Number of Transactions in Last 12M & Projection
Customer Revenue and Margin Trend in Last 12M & Projection
Customer Summary

Customer Products Portfolio dashboard, with charts and table reports:
Pricing Opportunity by Product Type
Pricing Opportunity by Product Attribute
Revenue and Margin Contribution
Pricing Opportunity by Top Products
Pricing Opportunity by Worst Products
Product Health Summary
Average Invoice Price
Trends
Pricing Opportunity
Selling Opportunity
Customer Summary
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Configurable

Customer Segmentation definition – You can define grouping of customers by common characteristics
/dimensions. Then selected KPIs of individual customers are calculated according to the values 
aggregated on the Customer Segment level.
Source of data – Defines from which source (Datamart / Data Source) your transactional data comes 
from and which fields should be used for calculations.
Parameters, which drive:

Calculations of KPIs – You can set class values and thresholds for various product and customer 
classifications.
Displaying of certain things – You can change lists of options for filters, and default presets for 
dashboard filters.

Waterfall chart configuration (it uses the configuration defined for the Sales Insights accelerator 
installed on the same partition)

Entitlement

Note that the data displayed in the dashboards cannot be restricted based on user groups of the logged in 
user.

Business User Reference (Customer Insights)
Customer Insights Dashboards consist of three separate dashboards which provide overview of trading 
performance of a customer group. They also support analysis of an individual customer’s performance.

Global View Dashboard (Customer Insights)
Customer Detail View Dashboard (Customer Insights)
Customer Products Portfolio Dashboard (Customer Insights)
Common Aspects of Dashboards (Customer Insights)

Global View Dashboard (Customer Insights)

Global View dashboard provides customer performance via health score and revenue, pricing and selling 
opportunity, and overall customer summary.

Portlets

All of the tables/charts are based on Data Source  if not stated Customer Insights Aggregated Data
otherwise.

Customer Summary
Customers Performance by Health Score Last 12M
Customers Performance by Revenue Last 12M
Customer Health Summary
Trends
Pricing Opportunity
Selling Opportunity
Inactive Customers
Filter Rules
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Customer Summary

Displays some typical figures regarding a chosen customer or a group of customers.

Customer displays a list of [Customer ID,(Customer Name)] following a filter group. When no customer 
is selected, it is left empty.
Health Score Last 12M is re-calculated by the Trend L12M of the group.
Pricing Opportunity = ∑ Revenue below target
Selling Opportunity = ∑ Up Sell + ∑ Cross Sell
L12M trends are calculated on the monthly basis.
Note: Data are queried from Datamart.

Customers Performance by Health Score Last 12M

Shows relative sizes of customer classification based on Heath Score in the last 12 months.

Customers Performance by Revenue Last 12M

Shows relative sizes of customer classification based on Revenue in the last 12 months.

Customer Health Summary

Shows Customer's Health calculated based on the difference between two periods. For example, Current 
YTD and Previous YTD.
It shows correlation between Health Score and revenue, gross margin, volume.
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Note:

Green/red color in the Customer column does not correspond to the Health score. See how it is .defined
If the revenue data are missing, then Margin % is null and this list of top customers is ordered by 
Customer ID. (But the customers are still listed because the application cannot resolve missing data on 
its own.)

Trends

For details on trends see .Common Aspects of Dashboards (Customer Insights)

Pricing Opportunity

Shows a list of customers who can be targeted to sell more products and more sales volume. The top of 
the list represents the highest opportunity, these customers are under the average point in the customers 
set. The bottom of the list represents the lowest opportunity. (hidden)

Revenue below target (Evaluate purchased products)
If the value > 0, customers have reached the revenue the average point among the under 
customers set, it indicates the value that customer should obtain to reach the average base.
If the value = 0, customers have reached the revenue the average point among the above 
customers set, they are good customers.

% Product Buying – Shows how many products (in % ) the customer purchased in the given period.
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If the value = 100%, the customer purchased full products set presented in the given period. It 
correlates with Cross Sell Opportunity = 0.
If the value < 100%, the customer did not purchase the full products set presented in the given 
period. It means this customer must have Cross Sell Opportunity > 0.

Selling Opportunity

Shows the total value which can be gained for products that the customer already bought and not bought 
in the given period.

Cross Sell (Evaluate non-purchased products)
The value that the customer should spend by purchasing a product which they did not buy in the 
past, but other customers bought it.
If the value = 0, the customer bought full products set presented in the given period.

Up Sell (Evaluate purchased products)
The value that the customer should spend more by purchasing a product which they already 
bought in the past.
If the value = 0, the customer purchased products that all are above average point in the 
customers set.

Opportunity – This is the total additional value that can be obtained for the customer, evaluate for 
both purchased and non purchased products.

Inactive Customers

This portlet shows a list of “inactive” customers so that you can identify customers which are marked as 
active and for which there are no transactions in the chosen time period.
Config Inactive-Customer-classification

Applied filters: Customer(s), Time filter
Not applied filters: Customer Rank, Customer Rank Bucket, KPI, Customer Class, Customer Health Score
Months Inactive = Current Month - Last Active Month
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User Inputs

To set up the dashboard, use these options:

Customer(s)
Time Filter – Possible values: MTD, QTD, YTD, L12M, L6M, L3M

For time filters with Last Period (L3M, L6M, L12M, …):
[Start date] = First month beginning date
[End date] = Previous month end date
E.g.: Today is 2021-08-06 => L3M: From 2021-05-01 to 2021-
07-31

For time filters with up To Date (YTD, QTD, MTD, …)
[Start date] = Period Beginning Date
[End date] = Current date
E.g.: Today is 2021-08-06 => QTD: From 2021-07-01 to 2021-
08-06

Customer Rank – Possible values: All, Top, Worst
Customer Rank Bucket – Possible values: 5,10, 50, 100

Counted items shown in the top or bottom of the list are based on the 
Rank Bucket input.
If the whole list has 12 customers and Customer Rank Bucket =10, 
then the top part of the list shows 10 customers and the bottom part 
shows 2 customers.
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 Customers column typically shows the top/worst aggregation of 
data which is driven by inputs on the left-hand side of the dashboard. 
Columns with Trends usually show increase/constant/decrease 
metrics based on the Data Load calculation results. There is no direct 
relation between these two types of metrics and columns.
KPI – Possible values: Revenue, Margin %, Volume, Health Score
Customer Class – Based on cumulative contribution to the total 
revenue in the last 12 months, the customer is assigned into a 
category (the thresholds are configurable).

A <= 20%
B <= 50%
C <= 95%
D = rest

Customer Health Score – Possible values: Excellent, Normal, Low, 
Problematic (multiselect is enabled). For details see Common Aspects 

.of Dashboards (Customer Insights)
Customer Base – Based on cumulative revenue contribution and the  
threshold defined, Customers are classified as either Core or Long 
Tailed. For detailed formula explanation see Glossary (Customer 

.Insights)
Core <=80%
Long Tailed > 80%

Filter Rules

Portlets User Inputs

Customer(s) Time Filter Customer 
Rank + 
Customer 
Rank Bucket

KPI Customer 
Class

Customer 
Health Score

Customer 
Base

Summary Customer 
Summary

X X X X X

Pie Chart Customers 
Performanc
e by Health 
Score Last 
12M

X X     X X X
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Customers 
Performanc
e by 
Revenue 
Last 12M

X X     X X X

Table Customer 
Health 
Summary

X X X X X X X

Trends X X X (*) X X X X

Pricing 
Opportunity

X X X (Ranked 
by Revenue 
Below 
Target 
descending)

X X X

Selling 
Opportunity

X X X (Ranked 
by 
Opportunity 
descending)

X X X

Inactive 
Customers

(*): Only sorts out Customers/Products that have traded in the period, does not affect calculation results.

Customer Detail View Dashboard (Customer Insights)

Customer Detail View dashboard provides a detailed customer view on revenue and margin, waterfall 
chart, high/low volume products, and revenue and margin trends.

Portlets

Customer Summary
Specialty and Commodity Products
High Volume and Low Volume Products
Revenue and Margin Chart
Waterfall Chart
Revenue Breakdown Chart
Number of Transactions in Last 12M & Projection
Customer Revenue and Margin Trend in Last 12M & Projection
Filter Rules
Commodity vs. Specialty Product

Customer Summary

Displays some typical figures regarding the chosen customer.

All values are aggregated on the Customer(s) and Category levels.
If a Category value is not selected, it will be hidden in the portlet.
On click “View Customer Products Portfolio” to open new tab “Customer Products Portfolio” dashboard.
L12M trends are calculated on monthly basis.
This chart is based on Datamart.
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Specialty and Commodity Products

Shows relative sizes of product classification based on the margin %.

Specialty products – Higher than the defined margin %
Commodity products – Lower than the defined margin %

The chart is based on Data Source .Customer Insights Aggregated Data

High Volume and Low Volume Products

Shows relative sizes of product classification based on volume. The chart is based on Data Source Custome
.r Insights Aggregated Data

Revenue and Margin Chart

Shows Revenue and Margin values over several months in the given period. The chart is based on Data 
Source .Customer Insights Aggregated Data
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Waterfall Chart

Shows a running total profit as values are added or subtracted. This chart is based on Datamart. For more 
details see .Waterfall Dashboard

Revenue Breakdown Chart

Shows what the difference in revenue between two periods can be attributed to. It allows you to compare 
two years or quarters and optionally filter for only certain products and/or customers. The chart is based 
on Data Source . For more details see Customer Insights Aggregated Data Revenue Breakdown Dashboard 

.- Fields Definition

Number of Transactions in Last 12M & Projection

Bar & line chart shows the number of transactions for the last 12 months and estimation for the next 3 
months. The current month is considered as a future month (as it has not ended yet). This chart is based 
on Datamart.

https://pricefx.atlassian.net/wiki/spaces/ACC/pages/4845929004/Waterfall+Dashboard
https://pricefx.atlassian.net/wiki/spaces/ACC/pages/4845930353/Revenue+Breakdown+Dashboard+-+Fields+Definition
https://pricefx.atlassian.net/wiki/spaces/ACC/pages/4845930353/Revenue+Breakdown+Dashboard+-+Fields+Definition
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Customer Revenue and Margin Trend in Last 12M & Projection

Bar & line chart shows Revenue and Margin for the last 12 months and estimation for the next 3 months. 
The current month is considered as a future month (as it has not ended yet). This chart is based on 
Datamart.

User Inputs

To set up the dashboard, use these options:

Customer
Time Filter – Possible values: MTD, QTD, YTD, L12M, L6M, L3M

For time filters with Last Period (L3M, L6M, L12M, …):
[Start date] = First month beginning date
[End date] = Previous month end date
E.g.: Today is 2021-08-06 => L3M: From 2021-05-01 to 2021-
07-31

For time filters with up To Date (YTD, QTD, MTD, …)
[Start date] = Period Beginning Date
[End date] = Current date
E.g.: Today is 2021-08-06 => QTD: From 2021-07-01 to 2021-
08-06

Category (+ ) – E.g.: Product ID, Product GroupValue
Product Class – Based on cumulative contribution to the total volume 
in the last 12 months, the product is assigned into a category (the 
thresholds are configurable).

Very High Volume <= 10%
High Volume <= 20%
Normal Volume <= 75%
Low Volume = rest

Product Health Score – Possible values: Excellent, Normal, Low, 
Problematic (multiselect enabled). For details see Common Aspects of 

.Dashboards (Customer Insights)
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Product Base – Based on cumulative revenue contribution and the 
threshold defined, Products are classified as either Core or Long 
Tailed. For detailed formula explanation see Glossary (Customer 

.Insights)
Core <=80%
Long Tailed > 80%

Filter Rules

  Portlets User Inputs

Customer Time Filter Category
+ Value

Product Class Product 
Health Score

Product Base

Summary Customer 
Summary

X X X X X X

Pie Chart Specialty and 
Commodity 
Products

X X X X X X

High Volume 
and Low 
Volume 
Products

X X X X X X

Bar Chart Revenue and 
Margin chart

X X X X X X

Waterfall 
chart

X X X X X X

Revenue 
Breakdown 
chart

X X X X X X

Number of 
Transactions 
in Last 12M & 
Projection

X   X X X X

Customer 
Revenue and 
Margin Trend 
in Last 12M & 
Projection

X   X X X X

Classification

Commodity vs. Specialty Product

Based on average margin achieved by the product during the last 12 months (the thresholds are 
configurable). For detailed formula explanation see .Glossary (Customer Insights)

Commodity <=40%
Specialty > 40%
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Customer Products Portfolio Dashboard (Customer Insights)

Customer Products Portfolio dashboard provides pricing opportunities by product type or attribute, 
identifies the top and bottom products.

Portlets

All of the tables/charts are based on Data Source .Customer Insights Aggregated Data
Customer Summary
Product Health Summary
Trends
Pricing Opportunity by Product Rank
Pricing Opportunity by Product Type
Pricing Opportunity by Product Attribute
Selling Opportunity
Pricing Opportunity
Revenue and Margin Contribution
Average Invoice Price
Filter Rules

Customer Summary

Displays some typical figures regarding the chosen customer, showing segment that the customer 
belongs to.

L12M trends are calculated on monthly basis.
Note in this portlet:

Data queried from : Trend YTD value here is the “customer DS [Customer Insights Aggregated Data]
YTD [revenue/margin/quantity] trend ” calculated in DS [Customer Insights Aggregated Data].
In , data queried from : Trend YTD value will be Customer Detail View dashboard Datamart
recalculated dynamically if the product filter is selected.

Meanwhile in Customer Products Portfolio dashboard: The trend YTD value will not change regardless 
of any product filter due to the complex calculation in this dashboard. This might be improved in the 
future, like in the Customer Detail View dashboard.
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Product Health Summary

Shows revenue and margin for top/worst products.
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 Green/red color in the Product column does not correspond to the Health score. See how it is .defined

Trends

Show trend values for top/worst products (ranked by Health Score). For details see Common Aspects of 
.Dashboards (Customer Insights)

Pricing Opportunity by Product Rank

Shows products (bars) by revenue below target descending and cumulative revenue below target (line). 
They are grouped by product ID.

This chart displays either Top or Worst Products – as selected in the Product Rank field.
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Pricing Opportunity by Product Type

Shows relative sizes of product classification based on the margin %.

Specialty Products – Higher than the defined margin %
Commodity Products – Lower than the defined margin %
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Pricing Opportunity by Product Attribute

Sums revenue below target by the input value in the product attribute filter. The chart label reflects the 
input value in the product attribute filter.

Selling Opportunity

Shows the total value which can be gained for products that the customer already bought and not bought 
in the given period. They are grouped by the input value in the product attribute filter.

Pricing Opportunity

Shows revenue below target value and % revenue below target. They are grouped by the input value in 
the product attribute filter.
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Revenue and Margin Contribution

Shows revenue and margin split into ten buckets to visualize the number of products needed to cover 
each bucket (cumulative contribution).

Average Invoice Price

Shows average unit price per product ID and customer classification by revenue.

Customer Revenue Class A/B/C/D – Average invoice price per product and customer classification.
Overall – Average invoice price per product and all customers
Customer – Average invoice price per product and customer.

Average invoice price calculated based on data in the last 12 months. Time filter has no effect in this 
table.
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User Inputs

To set up the dashboard, use these options:

Customer
Product Attribute – Relevant product related dimensions, by default it 
is Product Group. Values available here are fields from the Product 
Master table which are selected as "Dimension" in Product Data 
Source.
Time Filter – Possible values: MTD, QTD, YTD, L12M, L6M, L3M

For time filters with Last Period (L3M, L6M, L12M, …):
[Start date] = First month beginning date
[End date] = Previous month end date
E.g.: Today is 2021-08-06 => L3M: From 2021-05-01 to 2021-
07-31

For time filters with up To Date (YTD, QTD, MTD, …)
[Start date] = Period Beginning Date
[End date] = Current date
E.g.: Today is 2021-08-06 => QTD: From 2021-07-01 to 2021-
08-06

Product Rank – Possible values: All, Top, Worst
Product Rank Bucket – Possible values: 5, 10, 50, 100

Counted items shown in the top or bottom of the list are based on the 
Rank Bucket input.
If the whole list has 12 products and Product Rank Bucket =10, then 
the top part of the list shows 10 products and the bottom part shows 
2 products.
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 Product column typically shows the top/worst aggregation of data 
which is driven by inputs on the left-hand side of the dashboard. 
Columns with Trends usually show increase/constant/decrease 
metrics based on the Data Load calculation results. There is no direct 
relation between these two types of metrics and columns.
Product Class – Based on cumulative contribution to the total volume 
in the last 12 months, the product is assigned into a category (the 
thresholds are configurable).

Very High Volume <= 10%
High Volume <= 20%
Normal Volume <= 75%
Low Volume = rest

Product Health Score – Possible values: Excellent, Normal, Low, 
Problematic (multiselect enabled). For details see Common Aspects of 

.Dashboards (Customer Insights)
Product Base – Based on cumulative revenue contribution and the 
threshold defined, Customers and Products are classified as either 
Core or Long Tailed. For detailed formula explanation see Glossary 

.(Customer Insights)
Core <=80%
Long Tailed > 80%

Filter Rules

Portlets User Inputs

Customer Time Filter Product 
Attribute

Customer 
Rank + 
Customer 
Rank Bucket

Product 
Class

Product 
Health 
Score

Product 
Base

Summary Customer 
Summary

X X X X X

Pie Chart Pricing 
Opportunity 
by Product 
Type

X X   X X X

Bar Chart Pricing 
Opportunity 

X X X   X X X
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by Product 
Attribute

Revenue 
and Margin 
Contribution 

X X   X X X

Pricing 
Opportunity 
by Top 
Products

X X X X X

Pricing 
Opportunity 
by Worst 
Products

X X X X X X

Table Product 
Health 
Summary

X X X (by 
Health 
Score)

X X X

Average 
Invoice Price

X X (*) X (by 
Overall)

X X X

Trends X X (*) X (by 
Health 
Score)

X X X

Pricing 
Opportunity

X X X X X X X

Selling 
Opportunity

X X X X X X X

(*): Only sorts out Customers/Products that have traded in the period, does not affect calculation results.

Common Aspects of Dashboards (Customer Insights)

Customer Health Score, Product Health Score
Health Score Classes

Customer Segmentation
Trends Calculation
Create Quote from a Dashboard

Customer Health Score, Product Health Score

Customers or products are assigned into different classes based on Health Score calculated as a summary 
of Revenue Health Score and Margin Health Score (with weights set for particular inputs).

The Revenue Health Score and Margin Health Score are set according to the Revenue and Margin monthly 
change (trend) in the last 12 months (the maximum value is 100, the minimum value is 0) and to this 
classification:

Revenue or Margin Trend Last 12M Revenue or Margin Health Score

>25% 100

15% - 25% 75

5% - 15% 60
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-5% - 5% 50

-5% - -15% 40

-15% - -25% 25

< -25% 0

Health Score = Revenue Score * Revenue Weight + Margin Score * Margin Weight

The weight value is configurable and can be set between 0 and 1 for each (the default value is 0.5 for 
each); the summary of these two has to be equal to 1 (e.g. Revenue Weight = 0,5, Margin Weight = 0,5 => 
0,5 + 0,5 = 1).

If a customer or product is decreasing in revenue and margin, the Heath Score value goes down.

Health Score Classes

Excellent > 75
Normal > 50
Low > 25
Problematic = rest

Customer Segmentation

To group customers by common characteristics, the Customer Segment is defined in configuration (Price 
Parameters) – a list of fields the segment consists of, e.g. customer size, region, country etc.

According to values aggregated on the Customer Segment level, certain KPIs for particular customers are 
calculated, e.g. cross sell.

Trends Calculation

In many portlets there are Last 12M trends of particular KPIs (for example Revenue Trend Last 12M) 
presented either as such or as a part of a formula to calculate other KPIs.

The trends calculation granularity (time units between which the KPI change is considered) differs per 
various dashboards:

Global View: monthly
Detail View: monthly
Product Portfolio: monthly

In the Customer Summary portlets these are calculated always on the monthly level.

The formulas as such are described in .Glossary (Customer Insights)

Create Quote from a Dashboard

You can create a quote from the Customer Insights - Customer Products Portfolio dashboard, specifically 
from these portlets: Trends, Pricing Opportunity, and Selling Opportunity.
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1.  
a.  
b.  

2.  
3.  
4.  

Steps:

As inputs, select:
Customer and Time Filter which transactions exist.
Product Attribute = “Product Id”

Select a row in the result matrix.
Click the “Create Quote” button.
A new quote is created and opened and it includes the parameters passed from the dashboard. 
Quote Type is defined in the PP table “CI_QuoteType_Mapping”. 
If Quote Type is not defined in PP, the quote is created with the “default” Quote Type.

Example: Quote created from Trends, Quote Type = default (CPQ)

Example: Quote created from Selling Opportunity, Quote Type = CPQ



29

Admin User Reference (Customer Insights)
Mandatory Data (Customer Insights)
User Roles (Customer Insights)
Deployment (Customer Insights)
Architecture Components (Customer Insights)

Mandatory Data (Customer Insights)

Type Data Fields Use Case

Master 
Data

Customer Custom attributes (optional) Active/Inactive Customers identification
E.g. if CM.Attribute15 = “10” then the particular 
customer is considered active.
Customer segmentation (any other data source can be 
used as well)
For example, the segment can be defined by:

Country + Region
Customer Type + Customer Group
…

Product All the dimensions in the 
relevant Product Data 
Source (optional)

Customer Products Portfolio: Pricing and Selling 
Opportunities by Product Attribute:

Product Attribute defined by a user input, the filter 
items are loaded from the Data Source definition.
Used in Pricing Opportunities and Selling Opportunities 
portlets as a dimension (aggregation level).

Transacti
on Data

Sales Data 
(Transactions)

Unique ID
Customer ID
Customer Name
Product ID
Product Name
Pricing Date
Invoice Price
(Gross) Margin
Quantity

Core
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1.  

2.  
3.  
4.  

5.  

User Roles (Customer Insights)

To use Customer Insights Package, you need to be assigned the following Pricefx :user roles

Manage Price Lists (in the Price Setting section)
View Company Parameters (in the Price Setting section)
Manage PA Simulations (in Analytics section)

Deployment (Customer Insights)

Customer Insights Package is an extension of Sales Insights Package – it re-uses some Sales Insights 
components.

In this section:
A. Delete Previously Created Objects
B. Run Deployment from PlatformManager
C. Update Price Parameters and Advanced Configuration Options
D. Verify Number of Threads at Partition
E. Deploy & Run Calculation Flows (Manual Step)

As the current version of PlatformManager does not support all of the steps needed to deploy the 
Customer Insights Package, the step  needs to be performed Deploy & Run Calculation Flows (Manual Step)
manually.

A. Delete Previously Created Objects

If you are going to run deployment to a partition where Customer Insights Package had been installed 
before, it is recommended to delete the previously created objects, namely:

Simulation (located in Analytics module > Simulation: CustomerInsights)
Company Parameters (main menu Company Parameters > CustomerInsights: all)

This step can be skipped if it is obvious that no changes were made to these objects (Company 
Parameters structure) since the previous version (see ).Customer Insights Release Notes

B. Run Deployment from PlatformManager

Get access to PlatformManager and target partition, as described in common installation 
.prerequisites

Access PlatformManager at   and log in.https://platform.pricefx.com/
Go to  and find the  package.Marketplace Customer Insights
Click the accelerator package tile, select the partition where you want to deploy the package and 
confirm the deployment dialog to start.

 For detailed description of all deployment options, see .PlatformManager documentation
Set up Datamart mapping.

For the correct functionality, both Sales Insights Package1.6 and Customer Insights Package 1.6 
(or later versions) have to be present at the partition.

https://pricefx.atlassian.net/wiki/display/UNITY/User+Roles
https://pricefx.atlassian.net/wiki/display/ACC/Installation+Prerequisites+(Common+for+Accelerators)
https://pricefx.atlassian.net/wiki/display/ACC/Installation+Prerequisites+(Common+for+Accelerators)
https://platform.pricefx.com/
https://pricefx.atlassian.net/wiki/display/PM/How+to+Deploy+Accelerator+Package
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5.  

6.  
7.  

Select the Datamart name and field names (from the Datamart) for mapping and click .Continue
Wait for the system to finish the import.
The deployment is complete.

C. Update Price Parameters and Advanced Configuration Options

The Company Parameter needs to be consistent PFXTemplate_CustomerInsights_Customer_Segment 
with the partition data for the fields set as Active. This CP defines the fields used for a customer 
segmentation.

If the partition has some special setting (different from the Accelerator default setting), check and update 
the settings in other Company Parameters.
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1.  
2.  

3.  

For more details see .Company Parameters (Customer Insights)

D. Verify Number of Threads at Partition

Starting with Customer Insights Package version 1.6, it is recommended to have 8 threads per partition 
where Customer Insights is deployed. If the number is lower, Data Load calculations may fail.

By default, the value is lower, so you need to check with Pricefx Support. Threads are set by them as a 
server config parameter  for both  and .numberOfThreadsPerPartition paQuery paDataLoad

E. Deploy & Run Calculation Flows (Manual Step)

To keep the aggregated data (CI_AggregatedData Data Source) synchronized with customer classification 
data (CI_CustomerClassification Data Source), a scheduled job needs to be set to run the Data Load 
CI_CustomerClassification first and then run CI_AggregatedData Data Load (Distributed Calculation).

This can be done in Calculation Flows by taking these steps:

Go to >  > .Administration Configuration Calculation Flows
Find a calculation flow with the name “CustomerInsights_Sequencer”.

Select the “CustomerInsights_Sequencer” and update  and .Time Unit Number of Time Units
You define here how often the data will be refreshed and when. This setting has a big impact on 
the dashboard results and their validity.
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3.  

4.  

5.  

Click the button to deploy the calculation flow.Deploy 

When finished, the system will show more lines for the flows.
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5.  

6.  If you want to run the calculation flow immediately, select the row in the right window and then 
click .Run now

Architecture Components (Customer Insights)

Extension

Customer Insights Package is an extension of Sales Insights Package:

The configuration settings of waterfall chart is re-used from .Sales Insights

Advanced Configuration Option

customer-insights-accelerator – For details see .Advanced Configuration Options (Customer Insights)

Logics

Library Generic Logic

https://pricefx.atlassian.net/wiki/display/ACC/Waterfall+Dashboard+-+Details+on+Configuration
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CustomerInsights

PA Data Load

CustomerInsights_Aggregation_Sim

CustomerInsights_CustomerDetails
CustomerInsights_CustomerProductsPortfolio
CustomerInsights_DimensionFilter_Configurator
CustomerInsights_GlobalView

Dashboards

CustomerInsights_CustomerDetailView
CustomerInsights_CustomerProductsPortfolio
CustomerInsights_GlobalView

Customer Parameters

PFXTemplate_CustomerInsights_Configuration - incl. sample data
PFXTemplate_CustomerInsights_Customer_Segment - incl. sample data

For details see .Company Parameters (Customer Insights)

Analytics Simulation Datamart

CustomerInsights

Data Sources

CI_AggregatedData – Stores the pre-calculated data.
CI_CustomerClassification – Stores information on customer segments and active/inactive attribute for 
Customers.

Data Loads

CI_AggregatedData – Runs a logic to fill data into Data Source CI_AggregatedData. This is Data Load of 
the type Calculation+.
CI_CustomerClassification – Runs a logic to fill data into Data Source CI_CustomerClassification. This is 
Data Load of the type Calculation.

Calculation Flow

CustomerInsights_Sequencer – Keeps the data (Data Sources, Datamart) synchronized by filling the DS 
CI_CustomerClassification before the DS CI_AggregatedData is filled.

Preferences

Used for the dashboards - with layouts of the portlets.

Dependencies

This accelerator depends on the following accelerators which will be deployed during the installation too.

Shared Library
Dashboards Library
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Technical User Reference (Customer Insights)
Company Parameters (Customer Insights)
Advanced Configuration Options (Customer Insights)
Waterfall Chart Configuration (Customer Insights)
Groovy Libraries and Logics (Customer Insights)
Data Flow (Customer Insights)
Common Errors (Customer Insights)

Company Parameters (Customer Insights)

Customer Insights Package works based on configuration data which users can adjust to match their 
business case. These configuration data are stored in Company Parameter tables. In addition, the package 
uses Company Parameters tables to define currency symbols and Quote Types.

PFXTemplate_CustomerInsights_Configuration CP

Most parameters used in Customer Insights are saved in this table, including these main columns:

Category – Category of the configuration.
Key Name – Key name of the configuration.
Value – Defines the value corresponding to the key-set.
Is Default – If set to Yes, the dashboard will use the value of this item as a default value.
Order – Sets the order of items in the same Category.
Key Label – Defines a label shown on the chart/input.
Note – Specifies which logic type is used.

Dashboard Configuration

Time Filter Selector Input

Data for this selector are defined in Category = “MASTER_DATA” and Key 
Name = “TIME_FILTER“.

If you want to change the text shown in the Time Filter selector (e.g. 
MTD  Month To Date), you need to update the value of the column “Key 
Label” from “MTD” to “Month To Date“. If you clear the value of this 
column, the Time Filter selector will show the value of the “Value” column.
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Top/Worst Customers Selector Input

Data for this selector are defined in Category = “MASTER_DATA” and Key 
Name = “TOP_WORST_CUSTOMERS“.

If you want to add more values to this list, you need add a new row with 
same category and key name.

Example: To add a value “200” to the list and put it at the end of the list, 
you need to add the following:

Category= MASTER_DATA
Key Name = TOP_WORST_CUSTOMER
Value = 200
Order = 6

Top/Worst Products Selector Input

Data for this selector are defined in Category = “MASTER_DATA” and Key 
Name = “TOP_WORST_PRODUCTS“.

KPI Selector Input

Data for this selector are defined in Category = “MASTER_DATA” and Key 
Name = “KPI“.

If you want to change the text shown in the KPI selector (e.g. “Margin %”  
“Margin Percent”), you need to update the value of the column “Key 
Label” from “Margin %” to “Margin Percent“. If you clear the value of this 
column, the KPI selector will show the value of the “Value” column.

Display of Trend Columns in Table

In the tables of the 
dashboard, Trend columns 
are displayed with three 

You can define threshold values to match your business case – just 
update the value of the key name “TREND_UPPER“ and “TREND_LOWER”:
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formats based on the 
setting:

Green up arrow 
Orange horizontal 
arrow 
Red down arrow 

Green and up arrow Trend value >= TREND_UPPER

Orange and horizontal arrow TREND_LOWER <  < Trend value
TREND_UPPER

Red and down arrow Trend value <= TREND_LOWER

Display of Health Score Columns

This column has the same 
display format as the 
trends columns but the 
threshold is different.

The Health Score column is 
included in two tables: 
Customer Health Summary 
Table (Customer Global 
View Dashboard) and 
Product Health Summary 
Table (Customer Product 
Portfolio View Dashboard):

You can define it in Category = “CONFIGURATION“, the key names are 
“CUSTOMER_HEALTH_SCORE_UPPER“ and 
“CUSTOMER_HEALTH_SCORE_LOWER“:

Green and up arrow Health Score >= 
CUSTOMER_HEALTH_SCORE_UPPER

Orange and horizontal 
arrow 

CUSTOMER_HEALTH_SCORE_LOWER < H
 < ealth Score

CUSTOMER_HEALTH_SCORE_UPPER

Red and down arrow Health Score <= 
CUSTOMER_HEALTH_SCORE_LOWER

Revenue and Margin Contribution Chart (Customer Product Portfolio Dashboard)

In this chart, you can re-define:

Number of buckets – via the key name = “NUMBER_OF_BUCKETS“
Percent of the start bucket / percent of the end bucket via the key 
name =”BUCKET_START_PERCENT” and “BUCKET_END_PERCENT“

Number of Next months (Customer Detail View Dashboard)

In the Customer Detail 
View dashboard, we have 
two charts: “Customer 

The default number of next months is three. You can update this value in 
Category = ”MASTER_DATA” and key name = “NEXT_MONTH_AMOUNT“.
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Revenue And Margin 
Trend Last 12M & 
Projection” and “Number 
Of Transactions Trend Last 
12M & projection”.

Customer Base, Product Base (Core Customers and Products) Selector Input

Data for this selector are defined in Category = “Configuration” and Key 
Name = “CUSTOMER_CORE“ or “PRODUCT_CORE”.

The value specifies the cumulative revenue thresholds for the Core vs. 
Long Tailed definition.

Values range: 0..1 (e.g. 0.8 = 80%).

Pre-Processing (Simulation Logic) Configuration

Customer Health Score

For more details see .Glossary (CIP)

Health Score = Revenue Score * Revenue Weight + Margin Score * Margin Weight

Note: Revenue Weight + Margin Weight = 1

Revenue Score / Margin Score is based on the defined table (the Trend value is the revenue/margin trend 
last 12M ):

You can change the threshold trends value in the CP as shown below:
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You can change the Revenue Weight and Margin Weight values in the Company Parameter.

If you set just the value of Revenue Weight, the system will calculate Margin Weight = (1 - Revenue 
Weight) automatically.
If you set just the value of Margin Weight, the system will calculate Revenue Weight = (1 - Margin 
Weight) automatically.
If you do not set either of these values, the default value is: Revenue Weight = Margin Weight = 0.5.

Customer Revenue Classification

The simulation logic uses this setting to identify the customer classification based on the contribution and 
cumulative revenue contribution of each customer.

You can change the threshold value and label (show on the dashboard) in the PP as shown below:

Customer Health Score Classification

This classification is based on the customer health score – the simulation logic assigns customers to 
different classes based on Health Score.

You can change the threshold value and label (shown on the dashboard) in the PP as shown below:

Product Quantity Classification

The simulation logic uses this setting to identify the product classification based on the contribution and 
cumulative volume contribution of each product.

You define the threshold value in this CP, for example:

Very High Volume <= 10%
High Volume <= 20%
Normal Volume <= 75%
Low Volume = rest

You must update the threshold value and label (shown on the dashboard) in the CP as shown below:

Commodity vs. Specialty Product Classification

The simulation logic uses this setting to identify if a product is Commodity or Specialty Product.

It is defined based on an average margin achieved by the product.
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Speciality >= 30%
Commodity = rest

You can update the threshold value and label (shown on the dashboard) in the CP as shown below:

Inactive Customer classification

There is an option to define the name and value of the key which identifies active Customers in Customer 
Master (e.g., Customer Class = C -> active).
CP definition: category: CUSTOMER_MASTER_ACTIVE_KEY, fields: KEY_NAME, KEY_VALUE.

PFXTemplate_CustomerInsights_Customer_Segment CP

This table is used to define the customer segmentation. Customer segments can be obtained from multi 
data source types such as: Data Source, Customer Master, Customer Extensions. You can define it in this 
table.

You can add more customer attributes to the table if they are not present yet. Set the value of the Is 
Active column to YES, if you want to add this attribute into the segmentation processing and exclude the 
field with isCustomerId = YES. The field set to Is Customer Id = “YES” will join into the segment data, not 
the system uses it as a key to find data.

Main columns:

Source Type – Data Source types from which we get data for the customer segments. They include: 
DMDS (Data Source), C (Customer Master), CX (Customer Extension).
Source Name – Data source name.
Source Field – Source Field in the Data Source.
Field Label – Label of the field in the Data Source.
Is Active – If set to ‘YES’, the dashboard will add this field in the segmentation.
Is Customer Id – If this field is customer ID in a Data Source, set the value to ‘YES’. It helps the system 
get the correct “Customer Id” field in the source.
If the Data Source is Customer Master or Customer Extension, you do not need to add the “customer 
Id” field name.
If the Data Source is datasource, you must add the “customer Id” field name.

Note: For the field you want to be a key to find data in DMDS, you need to set IsActive = “YES” and 
IsCustomerId = YES”.

Example

We define that a customer segment will be obtained from the Data Source named 'Customer’ with these 
parameters:
Case 1: Segment data query from one source

Customer Type = active
Region = active
3 Customer Types = {Enduser, Industry, 

Case 2: Segment data query from two sources

Customer Type: get from Customer Master
Region: get from DMDS “Customer”
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Restaurant} 
4 Regions = {America, Oceania, Asia, Europe} 
=> We will have 3*4 = 12 Customer segments = 
{Enduser_America, Enduser_Oceania,…..}

Note: If the customer segment is queried from a 
Data Source, we add the ‘customer Id’ field must 
name in this source and set the value to ‘YES' in 
the 'Is Customer Id’ column.

You need to create a configuration like this:

Note:

When querying segment data from multiple 
sources, the system will take time to process 
(query and combine). You should consider this 
before processing.
If the segment data is large and complex for 
combination, you should create a DMDS to 
build the customer segment data first, then 
use it in this configuration for Customer 
Insights Package.

CurrencySymbols CP

This is a Company Parameter of Sales Insights Package and it should be deployed by this package. 
Customer Insights re-uses it to show the currency symbol in charts. If your currency is missing, you can 
add it to this table.

CI_QuoteType_Mapping CP

This table is used to define the Quote Type on each portlet of the dashboard. When a user selects multiple 
products and clicks the  button on a portlet, a new Quote with this Quote Type mapping will Create Quote
be created.

Currently, we support creating a new quote from 3 portlets of the Customer Products Portfolio dashboard, 
so this table has just 3 rows:

If you want to change Quote Type, you need to update the column “Quote Type” of this table from 
“__DEFAULT__” to your Quote Type name.
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Advanced Configuration Options (Customer Insights)

Customer Insights Package also uses the Advanced Configuration Option (AP) with the name “customer-
insights-accelerator“ to store:

Data source information
Mapping fields

This is a template for this Advanced Configuration Option:

Waterfall Chart Configuration (Customer Insights)

As Customer Insights is an extension of Sales Insights, the configuration of waterfall chart is re-used from 
Sales Insights. To update the waterfall configuration, follow .waterfall configuration details

Groovy Libraries and Logics (Customer Insights)

These are the main Groovy logics in this architecture:

CustomerInsights (Groovy library) The main library is used in the Customer Insights Dashboard logic. 
It provides functions to query and process data.

CustomerUtils Provides functions related to Customer such as: 
getAllCustomerIdsWithOtherAttributes, 
groupByCustomerAttributes

ProductUtils Provides functions related to Products such as: 
getProductAttributes, getSourceFieldsFromProductDataSource

DateUtils Provides functions related to dates.

Configuration Reads configured data from a price parameter and advanced 
configuration options.

https://pricefx.atlassian.net/wiki/display/ACC/Waterfall+Dashboard+-+Details+on+Configuration
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CustomerGlobalDashboard
Utils

Provides logics to process data to be shown in 
CustomerInsights_GlobalView dashboards.

CustomerDetailDashboard
Utils

Provides logics to process data to be shown in 
CustomerInsights_CustomerDetails dashboards.

CustomerProductPortfolioD
ashboardUtils

Provides logics to process data to be shown in 
CustomerInsights_CustomerProductsPortfoliodashboards.

CalculationCommonUtils Provides some common/calculation functions.

QueryUtils Provides functions to query data from the Datamart / Data Source.

Constant Defines constants used in the Customer Insights Dashboard.

DataTable Provides functions to build the row format of the result matrix to 
be displayed in the dashboard.

InputUtils Provides functions to build input controls such as: Time Filter, 
Category/Value…

Classification Provides logics to pre-process data such as: calculate Customer 
Health Score, Trends…

Used in dataload logic (CustomerInsights_DL_Aggregation).

ClassificationQueryHelper Provides functions to build a Query object to summarize data 
from Datamart / Data Source to use in Classification.

CalculationQueryHelper Provides functions to build a Query object to summarize data 
from Datamart / Data Source to use in Calculation.

SummaryPortletUtils Provides functions to create a summary data table (Summary 
portlet) in dashboards.

CustomerSegmentUtils Provides functions to query and build segment data from sources.

CommonDashboardParame
ter

Defines common parameters used in the package.

GlobalViewDashboardPara
meter

Defines parameters used in the Global View dashboard, they are 
inherited from Common Dashboard Parameter.

DetailViewDashboardPara
meter

Defines parameters used in the Detail View dashboard, they are 
inherited from Common Dashboard Parameter.

PortfolioDashboardParame
ter

Defines parameters used in the Portfolio dashboard, they are 
inherited from Common Dashboard Parameter.

DataLoadParameter Defines parameters used in the Data Load logic 
(CustomerInsights_DL_Aggregation), they are inherited from 
Common Dashboard Parameter.

InactiveCustomerUtils Provides functions to process inactive customers.



45

CommonChartUtils Provides functions to process charts in dashboards.

DataLoadUtils Provides functions to process Data Loads such as: find dataload…

SharedLib Groovy library to provide common functions.

HighchartsLibrary Groovy library to provide functions to build Highcharts shown on 
the dashboard.

Use version 1.1.2 and higher.

SIP_Dashboards_Commons Groovy library of Sales Insights, it re-uses some methods to build 
a waterfall chart in a dashboard.

CustomerInsights_DimensionFilter_
Configurator

Configurator logic to build the Category/Value input in 
dashboards.

CustomerInsights_GlobalView Customer Global View dashboard logic.

CustomerInsights_CustomerDetails Customer Detail View dashboard logic.

CustomerInsights_CustomerProduc
tPortfolio

Customer Product Portfolio dashboard logic.

CustomerInsights_DL_Aggregation Fills data into Data Source CI_AggregatedData

CustomerInsights_CF_Sequencer CF logic.

CustomerInsights_DS_CustomerCla
ssification

Fills data into Data Source CI_CustomerClassification.

Note: Almost all dashboard logics use SQL to have a better performance in case there are large data sets.

Data Flow (Customer Insights)

Overview
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In Customer Insights Accelerator, we use Data Load to aggregate Datamart data by customer, product and 
pricing month and we store it in the Data Source AggregatedData. It helps improve the dashboard 
performance because:

The system queries data in a smaller data set.
Some data need to be pre-processed before showing on dashboards as trend values, product and 
customer classification etc.

Note: There are some charts and portlets whose data are queried from the Datamart directly, not from 
AggregatedData Data Source, such as:

Customer Global View Dashboard: Customer Summary portlet
Customer Detail View: Customer Summary Portlet, Waterfall chart

Aggregated Data
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Customer Global View Dashboard
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Customer Detail View Dashboard
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Customer Product Portfolio Dashboard
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Common Errors (Customer Insights)

It is possible to encounter the following errors:
Cannot invoke method size () on null object
Load failed
Deployment fail with error “Cannot sync data source with DataMart in PriceFx core!”
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Use cases related to Data Loads (high transactions)

Cannot invoke method size () on null object

Where: CustomerInsights_DL_Aggregation

Troubleshooting:
Make sure the mapping fields are correct – go to Advanced Configuration Options and search for cus

.tomer-insights-accelerator

The columns DateMonth, DateQuarter, and DateYear must have data, they must not be empty 
because the logic reads data from these columns.

Load failed

Where: CustomerInsights_DL_Aggregation

Troubleshooting:
Increase the query thread pool in the partition which uses Customer Insights Accelerator (because 
dataload type = distributed_calculation is used and the logic does some queries. (For more details 
see the .)internal Pricefx Teams channel

Deployment fail with error “Cannot sync data source with DataMart in PriceFx core!”

Where: deployment result of Platform Manager

https://teams.microsoft.com/l/message/19:745dd1001bff4a2bb99d09639c62be22@thread.skype/1669211264860?tenantId=7894512c-f554-4de4-bff2-dec418150d4c&groupId=bc33397e-dcbb-492b-8726-9322ddbcf35e&parentMessageId=1669211264860&teamName=Functional%20Lounge&channelName=Accelerators&createdTime=1669211264860&allowXTenantAccess=false
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Troubleshooting:
Check the  and  master metadata in your partition again to ensure that ProductProduct Customer
/Customer master columns (attributes) are not duplicated. An attribute name should not be the 
same as another attribute's name.

Example: attribute2 (of Product master) has name=”attribute5” and attribute5 has a name (e.g: 
“Product class”), you should update name of attribute2 to be different with “attribute5”.

You can reproduce the error in the partition by going to the Product/Customer Data Source and 
clicking the  button.Sync Meta Data

If successful, you should not see this error in PlatformManager anymore.

Use cases related to Data Loads (high transactions)

It may help to check out the following discussions in  channel:internal Pricefx Teams

Customer Insights Aggregation DL fails with a streamQuery time out 
Accelerators, we have installed Customer Insights Package for Sullivan and… 
Error during DL_Aggregation calculation

 

Glossary (Customer Insights)
This glossary summarizes various terms used in Customer Insights Accelerator.

Term Description

Custo
mer 
Healt
h 
Score
Prod
uct 
Healt
h 
Score

Calculated based on the fields Revenue Trend Last 12 months and Margin Trend Last 12 
months.

The Revenue Health Score and Margin Health Score are set according to the Revenue and 
Margin monthly or quarterly change (trend) in the last 12 months ( the maximum value is 100, 
the minimum value is 0) and to this classification:

Example:

https://teams.microsoft.com/l/message/19:745dd1001bff4a2bb99d09639c62be22@thread.skype/1679268652115?tenantId=7894512c-f554-4de4-bff2-dec418150d4c&groupId=bc33397e-dcbb-492b-8726-9322ddbcf35e&parentMessageId=1679268652115&teamName=Functional%20Lounge&channelName=Accelerators&createdTime=1679268652115&allowXTenantAccess=false
https://teams.microsoft.com/l/message/19:745dd1001bff4a2bb99d09639c62be22@thread.skype/1682951798270?tenantId=7894512c-f554-4de4-bff2-dec418150d4c&groupId=bc33397e-dcbb-492b-8726-9322ddbcf35e&parentMessageId=1682951798270&teamName=Functional%20Lounge&channelName=Accelerators&createdTime=1682951798270&allowXTenantAccess=false
https://teams.microsoft.com/l/message/19:745dd1001bff4a2bb99d09639c62be22@thread.skype/1687944005598?tenantId=7894512c-f554-4de4-bff2-dec418150d4c&groupId=bc33397e-dcbb-492b-8726-9322ddbcf35e&parentMessageId=1687944005598&teamName=Functional%20Lounge&channelName=Accelerators&createdTime=1687944005598&allowXTenantAccess=false
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Revenue Trend Last 12M = -19.23% => Revenue score = 25
Margin Trend Last 12M = -18.84% => Margin score = 25

Health Score = Revenue Score  Revenue Weight  Margin Score Margin Weight * + * 

The weight value can be set (in the configuration in Price Parameters) between 0 and 1 for 
each (the default value is 0.5 for each); the summary of these two has to be equal to 1 (e.g. 
Revenue Weight = 0,5, Margin Weight = 0,5 => 0,5 + 0,5 = 1).

Custo
mer 
Classi
ficati
on 
by 
Reve
nue

This category should be calculated based on last 12 months. 

Calculation:

Get sorted (Descending) sum of revenue per customer.
Calculate value of each customer = Revenue of customer Revenue of all contribution ∑   / ∑
customers
Calculate revenue contribution per customer.cumulative 
Assigns Customers into different classes based on cumulative revenue contribution for the last 
12 months:

A ≤ 20% 
B ≤ 50% 
C ≤ 95% 
D rest
The thresholds are configurable.

Example:

Prod
uct 
Classi
ficati
on 
by 
Volu
me

This category should be calculated based on last 12 months. 

Calculation:

Get sorted (Descending) sum of volume per product
Calculate value per product= Volume per product Volume per all productscontribution ∑  / ∑
Calculate volume contribution per product.cumulative 
Assigns Products into different classes based on cumulative volume contribution for the last 12 
months:

Very High Volume ≤ 10%
High Volume ≤ 20%
Normal Volume ≤ 75%
Low Volume rest

The thresholds are configurable.
Example:
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Prod
uct 
Type

Classification whether the product belongs to Commodity or Specialty, is based on Margin % = 
Margin Value / Invoice Price value (Margin field depends on your mapping field.)

Commodity ≤ 40%
Specialty > 40%

The thresholds are configurable in the PP table.

Make sure the value =  Value of a product per all customers in the last 12 months (not per one ∑
customer).

=> We will have only one record to for Commodity, Specialty products based on the data for the 
last 12M.

When select YTD, MTD etc., the chart will sort out products that have transactions in that 
period; if a product does not exist in that period of a customer, it will not count.

E.g.: We have 30 products Commodity, 70 products Specialty in the last 12M.

For customer X in YTD, only 50 products have transactions, 20 of them is Commodity, the rest 
is Specialty, so the chart will show this accordingly.

Cross
Sell 
Oppo
rtunity

Formula = Average (Invoice) Price per Customer Segment and per period and for Products not 
bought by Customer

Example: Segment buys Product A, Product C and Product E, Customer A bought only Product A 
and Product E = > cross-sell would be an average Invoice Price of Product C per Customer 
Segment.

Customer Segment is defined in the configuration (Price Parameters) – a list of fields the 
segment consists of.

Reve
nue 
Incre
ase

If Quantity per Product and Customer  average Quantity per Product and per Customer <
Segment, then:

Formula =  average Quantity per Product and per Customer Segment Quantity per Product ( - 
and Customer  average Price per Product and Customer) * 

If Quantity per Product and Customer  average Quantity per Product and per Customer >
Segment, then:

Formula: Revenue Increase = 0

Example: Customer Segment buys Product A in Average 500 quantity and Customer bought 
350 quantity, then Revenue Increase = (500 – 350) * average Price per Customer. If Customer 
bought more than 500 quantity, then Revenue Increase = 0.

Customer Segment is defined in the configuration (Price Parameters) – a list of fields the 
segment consists of.
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Sellin
g 
Oppo
rtunity

= Cross Sell Opportunity  Revenue Increase+

% 
Prod
ucts 
buying

Formula = Number of Products buying in this period of a customer  Total of Products traded in /
this period  100*

Example: With YTD, total 200 products are traded. Among of them, customer A buys 50 
products.

% Products buying of customer A in YTD = 50/200 * 100 = 25 %

Reve
nue, 
Margi
n 
and 
Volu
me 
Tren
d 
Last 
12 
Mont
hs

 

First, the respective metric (revenue, margin or volume) is calculated for every single time unit.
Customer level: time unit = month
Product level: time unit = month

The least-square approach is used to compute the trend. See the Fitting a trend: Least-squares 
section in the  Wikipedia article.Linear trend estimation

Formula:

x is the month number (like month 1 would be the first month in scope)
x is the average month number
y is the metric to consider, like margin
y is the average metric to consider, like average margin

To convert the trend value â back to a percentage, the following formula is used: â / average
(metric)

Periods with no transactions are considered to have zero revenue, margin, and volume, and are 
included in the trend computation.

Find the example in the the following attachment:

This calculation is used in the following portlets:

https://en.wikipedia.org/wiki/Linear_trend_estimation
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1.  

2.  

3.  

1.  

2.  

3.  

Portlets affected by this trend calculation change:

Global View:
Customer Summary (Trends, Health Score)
Customer Health Summary (Health Score)
Trends (Trends)
Customer Detail View:
Customer Summary (Trends, Health Score)
Customer Products Portfolio
Customer Summary (Trends, Health Score)
Trends (Trends)
Product Health Summary (Health Score)
Average Invoice Price per Customer Revenue Class Last 12M (Product Classification)

Reve
nue, 
Margi
n 
and 
Volu
me 
Tren
d 
YTD

Formula: The least-square approach is used (see the Last 12 Months computation above).

This calculation is used in the following portlets:

Portlets affected by this trend calculation change:

Global View:
Customer Summary (Trends, Health Score)
Customer Health Summary (Health Score)
Trends (Trends)
Customer Detail View:
Customer Summary (Trends, Health Score)
Customer Products Portfolio
Customer Summary (Trends, Health Score)
Trends (Trends)
Product Health Summary (Health Score)
Average Invoice Price per Customer Revenue Class Last 12M (Product Classification)

Num
ber 
of 
Trans
actio
ns

Total Transactions in a given period  Total days in a given period /

Reve
nue 
Belo
w 
Targ
et

Average Invoice Price =  Average Unit Invoice Price for the particular Product ID and particular 
Customer Segment

Below Average Price = the particular Unit Invoice Price  Average Unit Invoice Price -

Revenue Below Target = if Below Average Price  0 then Below Average Price  Quantity  (-1) < *  *
else 0

% of 
Reve
nue 
belo
w 
Targ
et

Formula = Revenue Below Target  Revenue/

(calculated for Products with Revenue Below Target above zero)
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Pricin
g 
Oppo
rtunity

= Revenue Below Target

Custo
mer 
Segm
ent

To group customers by common characteristics, the Customer Segment is defined in 
configuration (Company Parameters) – a list of fields the segment consists of, e.g. customer 
size, region, country etc.

According to values aggregated on the Customer Segment level, certain KPIs for particular 
customers are calculated, e.g. cross sell.

Aver
age 
Invoi
ce 
Price 
per 
Custo
mer 
Reve
nue 
Class 
Last 
12M

(1) =  Invoice Price of Product   Qty of Product (per customer Last 12M)∑ / ∑
-> In Simulation, this field is called “Product Avg Price By Customer“
(2) =  (1) of Product Y of all customers in class A  Number of customers in class A that have ∑ /
product Y
Do the same with class B, C , D.
(6) Overall per product = Average { (2),(3),(4),(5) }

Core 
Custo
mers

Core: Customers having cumulative revenue contribution in the last 12M <= 80% (or by a PP) .
Long tailed: The remaining Customers/Products having cumulative revenue contribution in the 
last 12M > 80% (or by a PP).

Core 
Prod
ucts

Core: Products having cumulative revenue contribution in the last 12M <= 80% (or by a PP).
Long tailed: The remaining Customers/Products having cumulative revenue contribution in the 
last 12M > 80% (or by a PP).

For Products this is calculated per Customer Segment (as per the Segment definition).

Proje
cted 
Nr. 
of 
Trans
actio
ns, 
Margi
n 
and 
Reve
nue

(for 
the 
next 

Projected measure for the next 3 months (calculated as adjusted linear trend based on the first 
3 months of the period).

Calculation:

Projected measure for the particular month = linear trend for the particular month * Seasonality 
Adjustment

Seasonality Adjustment = (measure for the (particular month - 12 months) ) / Average of the 
value for the last 12 months)
If the projected value is negative, then we return 0 instead.

measure = Number of Transactions, Margin or Revenue

Example of Revenue projection calculation:



59

3 
mont
hs)

   Always make sure your data is complete. If, for example, the revenue data are missing, the following 
happens: 
revenue value = 0 
=> 
Margin % = Margin/Revenue 
=> 
Margin % = null

Null values may then appear in the dashboards because the application cannot resolve missing data on its 
own.

Release Notes (Customer Insights)
Customer Insights Dashboard 1.8
Customer Insights Dashboard 1.7
Customer Insights Dashboard 1.6
Customer Insights Dashboard 1.5
Customer Insights Dashboard 1.4
Customer Insights Dashboard 1.3
Customer Insights Dashboard 1.2
Customer Insights Dashboard 1.1
Customer Insights Dashboard 1.0

Customer Insights Dashboard 1.8

New Features and Improvements

Description ID

The trend calculation method has been changed: it is now based on the least-squares 
approach instead of the average of monthly changes.

PFPCS-8297
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Customer Insights Dashboard 1.7

Upgrade Notes

New Company Parameter Table

This table allows users to configure Quote Type mapping for each portlet of the dashboards. When you 
select multiple products and click the “Create Quote” button in the dashboard, a new Quote with the 
corresponding Quote Type mapping will be created.

Name: CI_QuoteType_Mapping
Type: Matrix
Value Type: Matrix 2
Default data:

Manual Update of Logics

These logics should be added or updated:

CustomerInsights Update

CustomerInsights_ProductPortfolio Update

CustomerInsights_QuotingCreation Add

New Features and Improvements

Description ID

It is possible to create a , using products new Quote directly from the dashboard
selected in the dashboard.

PFPCS-5913

Customer Insights Dashboard 1.7.1

Bugs

PFPCS-6624 Update CI deployment script to fix issue: removing Customer/Product data

Customer Insights Dashboard 1.7.2

This document summarizes major improvements and fixes introduced in the Accelerate Customer Insights 
release version.

Version 1.7.2

https://pricefx.atlassian.net/browse/PFPCS-6624
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Release Date Apr 5, 2023

Improvements

Description ID

To allow for safe and convenient upgrades to the latest version, there is now “Customer 
Insights Package - Upgrade” package available.

PFPCS-
6602

Documentation has been improved based on customer feedback.  PFPCS-
6628

In the Detail view, "Product Base" filter is not passed after clicking “View Customer 
Products Portfolio”.

PFPCS-
6643

Validation YTD value has been adjusted: PFPCS-
6645

Customer Insights Dashboard 1.7.3

This document summarizes major improvements and fixes introduced in the Accelerate Customer Insights 
Dashboard release version.

Version 1.7.3

Release Date May 22, 2023

Improvements

Description ID

Increase all dashboard logic elements timeouts to 300. PFPCS-6806

Bugs

Description ID

Fix performance of Product Portfolio dashboard when loading. PFPCS-6797
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Customer Insights Dashboard 1.6

Incompatibility with 1.5.0
Upgrade Notes
Bugs
Change Requests
Sub-tasks
Tasks

Incompatibility with 1.5.0

Due to changes in  the Simulation object created in 1.5.0 will not be supported in this version. PFPCS-5933
The main functionality is kept unchanged.

Upgrade Notes

Due to  there are several changes that need to happen during upgrade from 1.5.0 to 1.6.0. PFPCS-5933
The changes are:

Note: Objects contents are available here:

Add:
Data Source:

CI_AggregatedData

Logics:
CustomerInsights_DL_Aggregation (Data Load logic)
Data Load:

DMDS.CI_AggregatedData
Update:

Content of Advanced Configuration named “customer-insights-accelerator”
Logics:

CustomerInsights (Groovy library)
CustomerInsights_CF_Sequencer (CF logic)
CustomerInsights_DS_CustomerClassification (Data Load logic)
CustomerInsights_GlobalView (dashboard logic)

https://pricefx.atlassian.net/browse/PFPCS-5933
https://pricefx.atlassian.net/browse/PFPCS-5933
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CustomerInsights_CustomerDetails (dashboard logic)
CustomerInsights_CustomerProductPortfolio (dashboard logic)

Remove:
Simulation: CustomerInsights
Logic: CustomerInsights_Aggregation_Sim

Bugs

PFPCS-6308 Detail view: Customer summary portlet: displaying incorrectly

PFPCS-6294 Error when select filters of class

PFPCS-6274 Fix performance issue for Customer Product Portfolio dashboard

PFPCS-6254 Wrong field name of Data Source CI_AggregatedData

Change Requests

PFPCS-5933 Replace Simulation with another data source

Sub-tasks

PFPCS-6313 [Detail Dashboard] refactor api.local.xxx using to pass value to elements

PFPCS-6269 [Customer Product Portfolio] Update logics to make dashboard Customer Product Portfolio 
work with new data source

PFPCS-6268 [Customer Detail] Update logics to make dashboard Customer Detail View work with new 
data source

PFPCS-6184 Change/Update Calculation Flow to work with new Data Source

PFPCS-6183 [Customer Global] Update logic to make dashboard Customer Global work with new data 
source

PFPCS-6182 Update package-definition

PFPCS-6181 Update Simulation logic to data load logic

PFPCS-6138 Investigate Solution Change Simulation to Data Source using Data Load logic

PFPCS-4564 [Portfolio Dashboard] refactor api.local.xxx using to pass value to elements

PFPCS-4563 [Global View Dashboard] refactor api.local.xxx using to pass value to elements

Tasks

PFPCS-6271 Update logic CustomerInsights_DimensionFilter_Configurator based on new structure of 
Configuration

PFPCS-6265 Update DS Customer Classification logic to match with new structure Configuration

PFPCS-6251 Update structure of Configuration

PFPCS-4560 [Dashboard] refactor api.local.xxx using to pass value to elements

Customer Insights Dashboard 1.6.1

Bugs

https://pricefx.atlassian.net/browse/PFPCS-6308
https://pricefx.atlassian.net/browse/PFPCS-6294
https://pricefx.atlassian.net/browse/PFPCS-6274
https://pricefx.atlassian.net/browse/PFPCS-6254
https://pricefx.atlassian.net/browse/PFPCS-5933
https://pricefx.atlassian.net/browse/PFPCS-6313
https://pricefx.atlassian.net/browse/PFPCS-6269
https://pricefx.atlassian.net/browse/PFPCS-6268
https://pricefx.atlassian.net/browse/PFPCS-6184
https://pricefx.atlassian.net/browse/PFPCS-6183
https://pricefx.atlassian.net/browse/PFPCS-6182
https://pricefx.atlassian.net/browse/PFPCS-6181
https://pricefx.atlassian.net/browse/PFPCS-6138
https://pricefx.atlassian.net/browse/PFPCS-4564
https://pricefx.atlassian.net/browse/PFPCS-4563
https://pricefx.atlassian.net/browse/PFPCS-6271
https://pricefx.atlassian.net/browse/PFPCS-6265
https://pricefx.atlassian.net/browse/PFPCS-6251
https://pricefx.atlassian.net/browse/PFPCS-4560
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PFPCS-6327 Data Load sometimes fails with errors. Use the api.getDatamartContext().streamQuery
(batchQuery) function instead of the api.getDatamartContext().consumeData().

Customer Insights Dashboard 1.5

Bugs
Improvements
Stories
Sub-tasks
Tasks

Bugs

PFPCS-5128 Portfolio: Customer Summary portlet: Opportunity value sum all regardless Product Rank = 
Top/Worst

PFPCS-5107 Portfolio: Some portlets not show full list products when size list < Product rank bucket

PFPCS-4963 Portfolio: Selling Opportunity: fields order change per filter values

PFPCS-4811 [Customer Product Portfolio] - Missing product when Product Rank = Top

PFPCS-4809 [Portfolio]: Pricing Opportunity By Product Type Chart: not count Top/Worst list

PFPCS-4379 Trend L12M & Projection chart: missing two bars

PFPCS-4373 Inactive Customers portlet: still show customers which have transactions in time period

PFPCS-4310 Tooltips display incorrectly in some charts

PFPCS-4272 Portfolio: Customer Summary: Opportunity value always sum "all" regardless product rank 
selection

PFPCS-4266 [Portfolio Dashboard] Wrong data on Pricing Opportunity By Product Rank chart

PFPCS-4231 Portfolio: Opportunity values, Revenue Below target are incorrect when select Product Class
/Health Score

PFPCS-4230 Global View: Opportunity values, Revenue Below target are incorrect when select customer 
Class/Health Score

PFPCS-4216 [Portfolio Dashboard] Wrong Pricing/Selling Opportunities on Customer Summary Portlet

Improvements

PFPCS-5373 Customer Product Portfolio View: Pricing Opportunity By Product Type Chart and Pricing 
Opportunity By Product Attribute Chart - Update tooltip label

PFPCS-5372 Customer Product Portfolio View: Update tooltip label

PFPCS-5183 Detail View: add total volume into High Volume vs Low Volume Products portlet hint

PFPCS-4743 Detail View: Allow to override the mapped parameters with filters

PFPCS-4493 Allow drill-down in pie charts

PFPCS-4492 Allow columns sorting for all tables

PFPCS-4375 Update CustomerInsights.GlobalViewDashboardParameter and Global View Dashboard logic

https://pricefx.atlassian.net/browse/PFPCS-6327
https://pricefx.atlassian.net/browse/PFPCS-5128
https://pricefx.atlassian.net/browse/PFPCS-5107
https://pricefx.atlassian.net/browse/PFPCS-4963
https://pricefx.atlassian.net/browse/PFPCS-4811
https://pricefx.atlassian.net/browse/PFPCS-4809
https://pricefx.atlassian.net/browse/PFPCS-4379
https://pricefx.atlassian.net/browse/PFPCS-4373
https://pricefx.atlassian.net/browse/PFPCS-4310
https://pricefx.atlassian.net/browse/PFPCS-4272
https://pricefx.atlassian.net/browse/PFPCS-4266
https://pricefx.atlassian.net/browse/PFPCS-4231
https://pricefx.atlassian.net/browse/PFPCS-4230
https://pricefx.atlassian.net/browse/PFPCS-4216
https://pricefx.atlassian.net/browse/PFPCS-5373
https://pricefx.atlassian.net/browse/PFPCS-5372
https://pricefx.atlassian.net/browse/PFPCS-5183
https://pricefx.atlassian.net/browse/PFPCS-4743
https://pricefx.atlassian.net/browse/PFPCS-4493
https://pricefx.atlassian.net/browse/PFPCS-4492
https://pricefx.atlassian.net/browse/PFPCS-4375
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PFPCS-4374 Update CustomerInsights.CommonDashboardParamater

PFPCS-4198 Dashboards order in label

Stories

PFPCS-5523 Add detailedDescription to steps.json mentioning that deploying SIP is mandatory

PFPCS-5442 Data tab in chart-based portlets

PFPCS-5427 Mixpanel tracking for CIP - dashboard view

PFPCS-4119 Core Customers/Products

PFPCS-4118 Inactive Customers

PFPCS-4117 Only Top, Worst or all the Customer/Products are displayed in dashboards

Sub-tasks

PFPCS-4566 Move duplicated functions for drilldown chart in 3 dashboard to Common in library

PFPCS-4557 [Global View] Allow drill-down in pie charts

PFPCS-4555 [Product Portfolio] Allow drill-down in pie charts

PFPCS-4214 Add new inputs on Customer Product Portfolio View dashboards

PFPCS-4213 Add new inputs on Customer Detail View dashboards

PFPCS-4212 Add new inputs on Customer Global View dashboards

PFPCS-4211 Add new process for Customer Core in Simulation

PFPCS-4210 Add new process for Product Core in Simulation

PFPCS-4124 Add new inputs on Customer Products Portfolio dashboards

PFPCS-4123 Add new inputs on Customer Global View dashboard

PFPCS-4122 Change Top/Worst Customers and Top/Worst Products

Tasks

PFPCS-5617 Update Element Doc and Method docs for dashboard logics

PFPCS-5606 Hide warnings for all the portlets

PFPCS-5432 Detail View, Portfolio: Customer Input mandatory

PFPCS-5431 Deployment step: Add the text noting the importance of having SIP deployed first

PFPCS-5377 Should remove date string in logic folder name

PFPCS-5206 Update document about new object in CID as: Datasource "CI Customer Insight" and CF

PFPCS-4960 Global View: Pricing Opportunity - incorrect KPI label

PFPCS-4607 Update return structure function of CustomerSegmentUtils.getCustomerSegment()

PFPCS-4599 [Global View Dashboard] Update Inactive Customers Portlet

PFPCS-4598 Add CF logic to handle dataload and simulation schedule

PFPCS-4585 CI_CustomerClassification DS

https://pricefx.atlassian.net/browse/PFPCS-4374
https://pricefx.atlassian.net/browse/PFPCS-4198
https://pricefx.atlassian.net/browse/PFPCS-5523
https://pricefx.atlassian.net/browse/PFPCS-5442
https://pricefx.atlassian.net/browse/PFPCS-5427
https://pricefx.atlassian.net/browse/PFPCS-4119
https://pricefx.atlassian.net/browse/PFPCS-4118
https://pricefx.atlassian.net/browse/PFPCS-4117
https://pricefx.atlassian.net/browse/PFPCS-4566
https://pricefx.atlassian.net/browse/PFPCS-4557
https://pricefx.atlassian.net/browse/PFPCS-4555
https://pricefx.atlassian.net/browse/PFPCS-4214
https://pricefx.atlassian.net/browse/PFPCS-4213
https://pricefx.atlassian.net/browse/PFPCS-4212
https://pricefx.atlassian.net/browse/PFPCS-4211
https://pricefx.atlassian.net/browse/PFPCS-4210
https://pricefx.atlassian.net/browse/PFPCS-4124
https://pricefx.atlassian.net/browse/PFPCS-4123
https://pricefx.atlassian.net/browse/PFPCS-4122
https://pricefx.atlassian.net/browse/PFPCS-5617
https://pricefx.atlassian.net/browse/PFPCS-5606
https://pricefx.atlassian.net/browse/PFPCS-5432
https://pricefx.atlassian.net/browse/PFPCS-5431
https://pricefx.atlassian.net/browse/PFPCS-5377
https://pricefx.atlassian.net/browse/PFPCS-5206
https://pricefx.atlassian.net/browse/PFPCS-4960
https://pricefx.atlassian.net/browse/PFPCS-4607
https://pricefx.atlassian.net/browse/PFPCS-4599
https://pricefx.atlassian.net/browse/PFPCS-4598
https://pricefx.atlassian.net/browse/PFPCS-4585
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PFPCS-4569 Update Map keys in CustomerInsight.Configuration to camelCase

PFPCS-4275 [CID] Logic to get Top and Worst list with bucket to show on tables

PFPCS-4199 Reformat all code

Customer Insights Dashboard 1.5.1

Bugs

PFPCS-5718 Address the division-by-zero cases in logic

Customer Insights Dashboard 1.4

Improvements

PFPCS-3693 Add DISTINCT into SQL

PFPCS-3674 Mapped Customer parameter for Detail View

PFPCS-3669 Detail View > Revenue and Margin > No-data indication

PFPCS-3656 Summary portlets - no data indication

PFPCS-3655 Detail View - Waterfall - no-data indication

PFPCS-3628 Update Get currency of Datamart

PFPCS-3530 Customer segment PP - more effective default setting

PFPCS-3525 Update deployment script for customer insight

PFPCS-3474 Dashboards labels adjustment

PFPCS-3404 Detail View - Revenue Breakdown - no-data indication

PFPCS-3403 Create some wrapper for SummaryPortletUtils.initTableItem()

 [Simulation] Update some elements to improve performancePFPCS-3350

PFPCS-3348 [Simulation] Update cache in some elements and function to improve performance

PFPCS-3337 [Simulation] Update SQL for Customer Classification by Revenue and Product Classification 
by Volume

PFPCS-3322 [Simulation] Update element GetProductAvgPriceByCustomer And 
ProductAvgPriceByCustomer

PFPCS-3300 Multiple sources for Customer segment

PFPCS-3298 [CID] add into Simulation more field ProductClassificationByHealthScore.

PFPCS-3238 Charts > Add 1000 separator to displayed number

PFPCS-3203 Product Portfolio - Health Score filter

PFPCS-3202 Detail View - Health Score filter

PFPCS-3199 Global View - Health Score

https://pricefx.atlassian.net/browse/PFPCS-4569
https://pricefx.atlassian.net/browse/PFPCS-4275
https://pricefx.atlassian.net/browse/PFPCS-4199
https://pricefx.atlassian.net/browse/PFPCS-5718
https://pricefx.atlassian.net/browse/PFPCS-3693
https://pricefx.atlassian.net/browse/PFPCS-3674
https://pricefx.atlassian.net/browse/PFPCS-3669
https://pricefx.atlassian.net/browse/PFPCS-3656
https://pricefx.atlassian.net/browse/PFPCS-3655
https://pricefx.atlassian.net/browse/PFPCS-3628
https://pricefx.atlassian.net/browse/PFPCS-3530
https://pricefx.atlassian.net/browse/PFPCS-3525
https://pricefx.atlassian.net/browse/PFPCS-3474
https://pricefx.atlassian.net/browse/PFPCS-3404
https://pricefx.atlassian.net/browse/PFPCS-3403
https://pricefx.atlassian.net/browse/PFPCS-3350
https://pricefx.atlassian.net/browse/PFPCS-3348
https://pricefx.atlassian.net/browse/PFPCS-3337
https://pricefx.atlassian.net/browse/PFPCS-3322
https://pricefx.atlassian.net/browse/PFPCS-3300
https://pricefx.atlassian.net/browse/PFPCS-3298
https://pricefx.atlassian.net/browse/PFPCS-3238
https://pricefx.atlassian.net/browse/PFPCS-3203
https://pricefx.atlassian.net/browse/PFPCS-3202
https://pricefx.atlassian.net/browse/PFPCS-3199
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PFPCS-3198 Product Portfolio - Product Class filter

PFPCS-3197 Detail View - Product Class filter

PFPCS-3196 Global View - Customer Class filter

Tasks

PFPCS-3489 [Simulation] Update parameter structure based on solution as dashboard

PFPCS-3438 Detail View - Update waterfall chart in CID because SIP_Dashboards_commons had been 
changed

PFPCS-3410 [CID] typo in the element name "CustomerProductPortfolioDahboardUtils"

PFPCS-3355 Split Calculation element in CustomerInsights library into 3 sub-elements

PFPCS-3338 Detail View > Pass values in new filters to Portfolio dashboard

PFPCS-3280 [Customer Detail View] Check changes in SIP_Dashboards_commons and update for CID PFPC
 Check whether it's possible to move certain calculations to SQLS-3256

PFPCS-3177 The InputParams solution: new structure

PFPCS-3053 Redesign Customer Segment PP Table

Bugs

PFPCS-3699 Detail View > Waterfall chart display value when no data

PFPCS-3386 Total number values in tables should be integer

Customer Insights Dashboard 1.4.5

Bugs

PFPCS-4284 [Simulation] wrong calculation of YTD Trends

Customer Insights Dashboard 1.3

Bugs

[ ] - Hotfix- Portfolio_ Average invoice price tablePFPCS-3003
[ ] - [Detail View]> Chart > Nr. of Transaction trend last 12M& projection: Number of PFPCS-3086
transactions is incorrect
[ ] - [Detail View] > Customer Summary > Remove "YTD" in Total revenue/margin/volumePFPCS-3137
[ ] - [Portfolio] > Chart > Pricing Opportunity by Product Type > Tooltip> Not show % valuePFPCS-3140
[ ] - [Detail View] > Waterfall > Not show data like SIPPFPCS-3142
[ ] - [Portfolio] > Table: Selling Opportunity > Column: Opportunity > Not show valuePFPCS-3157
[ ] - [Customer Product Portfolio]Error in Tooltip of Revenue And Margin Contribution chartPFPCS-3172
[ ] - Detail View > Customer Summary > Segment does not displayPFPCS-3213
[ ] - Global View > Pie charts > Avg. Margin % is incorrectPFPCS-3232

Tasks

[ ] - Update document for new version 1.3PFPCS-3013
[ ] - Create generator for process of tablePFPCS-3059

https://pricefx.atlassian.net/browse/PFPCS-3198
https://pricefx.atlassian.net/browse/PFPCS-3197
https://pricefx.atlassian.net/browse/PFPCS-3196
https://pricefx.atlassian.net/browse/PFPCS-3489
https://pricefx.atlassian.net/browse/PFPCS-3438
https://pricefx.atlassian.net/browse/PFPCS-3410
https://pricefx.atlassian.net/browse/PFPCS-3355
https://pricefx.atlassian.net/browse/PFPCS-3338
https://pricefx.atlassian.net/browse/PFPCS-3280
https://pricefx.atlassian.net/browse/PFPCS-3256
https://pricefx.atlassian.net/browse/PFPCS-3256
https://pricefx.atlassian.net/browse/PFPCS-3177
https://pricefx.atlassian.net/browse/PFPCS-3053
https://pricefx.atlassian.net/browse/PFPCS-3699
https://pricefx.atlassian.net/browse/PFPCS-3386
https://pricefx.atlassian.net/browse/PFPCS-4284
https://pricefx.atlassian.net/browse/PFPCS-3003
https://pricefx.atlassian.net/browse/PFPCS-3086
https://pricefx.atlassian.net/browse/PFPCS-3137
https://pricefx.atlassian.net/browse/PFPCS-3140
https://pricefx.atlassian.net/browse/PFPCS-3142
https://pricefx.atlassian.net/browse/PFPCS-3157
https://pricefx.atlassian.net/browse/PFPCS-3172
https://pricefx.atlassian.net/browse/PFPCS-3213
https://pricefx.atlassian.net/browse/PFPCS-3232
https://pricefx.atlassian.net/browse/PFPCS-3013
https://pricefx.atlassian.net/browse/PFPCS-3059
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[ ] - Group some constants in libraryPFPCS-3077
[ ] - [CID] Remove some unused variables and methodsPFPCS-3094
[ ] - [Product Portfolio] > Tables: Selling Opportunity & Pricing Opportunity > Show top PFPCS-3096
products
[ ] - [CID] Rename function DataTable.setTopWorstData to DataTable.setDataPFPCS-3104
[ ] - [Customer Global View] update URL in CustomerSummary portlet get from constantPFPCS-3124
[ ] - [CID] move some string to ConstantPFPCS-3126
[ ] - [CID] Update some variable namesPFPCS-3127
[ ] - [CID] add "setup Simulation" step into deployment ScriptPFPCS-3193
[ ] - Add Unity preferences from QA to packagePFPCS-3201
[ ] - [Customer Global View] Change color setting from Constant of SIP to Dashboard of CIDPFPCS-3225

Improvements

[ ] - Refactor code base on Code reviewPFPCS-2769
[ ] - [Customer Detail View] Data of Waterfall chart should be queried from DM, not query PFPCS-2876
from Simulation
[ ] - Update currency code and symbol in ChartPFPCS-2878
[ ] - [Customer Product Portfolio] Update/refactor chart "Revenue And Margin Contribution"PFPCS-3012
[ ] - Detail View, Portfolio > Customer Summary > Remove "s" in label "Customers"PFPCS-3215

Stories

[ ] - Consistency for values in Average Invoice Price tablePFPCS-3006

Customer Insights Dashboard 1.2

New Features

[ ] - [Customer Global View] Add more Customer Summary portletPFPCS-2766
[ ] - [Customer Product Portfolio] Add Customer Summary portletPFPCS-2767

Improvement

[ ] - [Customer Detail View] Change the summary portletPFPCS-2930

Bugs

[ ] - [Detail View_Summary] Category row should be hidden if no value selectedPFPCS-2908
[ ] - [Customer Summary portlet]_Trend symbol is incorrectPFPCS-2912
[ ] - [Customer Product Portfolio] Total Revenue/Margin/Volume in Summary portlet should PFPCS-2972
be calculated based on time filter

Customer Insights Dashboard 1.1

Bugs

[ ] - [Chart Pricing Opportunity by Product Attribute]_No spacing between wordsPFPCS-2722
[ ] - Trend L12M is inaccurately for those products that data exists in just one quarterPFPCS-2729
[ ] - [CID] Hotfix Preferences for Customer Insights Dashboards on Unity modePFPCS-2744

https://pricefx.atlassian.net/browse/PFPCS-3077
https://pricefx.atlassian.net/browse/PFPCS-3094
https://pricefx.atlassian.net/browse/PFPCS-3096
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Tasks

[ ] - Write document for CIDs IntroductionPFPCS-2564
[ ] - [CID] Do release activities for version 1.1.0PFPCS-2742

Improvements

[ ] - Customer Summary _Not display null/zero when no data existPFPCS-2568
[ ] - Update list value in Category in dashboard inputPFPCS-2569
[ ] - Support change label of some params configured in PPPFPCS-2574
[ ] - Rename column "Field Name" in PP PFPCS-2590
"PFXTemplate_CustomerInsights_Customer_Segment" to "Source Field"
[ ] - Customer Summary portlet_ Little updatesPFPCS-2610
[ ] - [Customer Global View] add click-through from the Trends tablePFPCS-2634
[ ] - Update: using sourceField to match data between Product master and Product PFPCS-2643
datasource
[ ] - Update some points in charts and tablePFPCS-2652
[ ] - Update The Health Score calculationPFPCS-2656
[ ] - [Simulation] Support multi order type of classification rangesPFPCS-2689
[ ] - [dashboard] Using constants defined in libraryPFPCS-2708
[ ] - [Customer Detail View] Should round before pass value to function api.formatNumberPFPCS-2709
[ ] - [Customer Product Portfolio] Product Attribute should show label TranslationsPFPCS-2713
[ ] - Should use key label in configuration PP to show in KPI dropdown listPFPCS-2715
[ ] - Should use key label in configuration PP to show in Timefilter dropdown listPFPCS-2716
[ ] - CID update default Preferences for dashboardsPFPCS-2726

Customer Insights Dashboard 1.0

New Features

[ ] - Potential by Product AttributePFPCS-1717
[ ] - Open a new dashboard in a new web browser tabPFPCS-2328
[ ] - [Customer Product Portfolio]_Adding Product Health ScorePFPCS-2400
[ ] - [Customer Product Portfolio]_ new table: Cross-Sell and Up-Sell OpportunityPFPCS-2402
[ ] - [Customer Global View]_ new table: Cross-Sell and Up-Sell OpportunityPFPCS-2445

Stories

[ ] - Customer Insight DashboardPFPCS-16
[ ] - Aggregated Datamart for YTD dataPFPCS-419
[ ] - Documentation - Aggregated DatamartPFPCS-689
[ ] - Documentation - Dashboard ConfigurationPFPCS-690
[ ] - Data Pre-processingPFPCS-1203
[ ] - Customer Insights - Customer DetailsPFPCS-1204
[ ] - Update Customer Revenue And Margin Trend Last 12M & Projection chartPFPCS-1306
[ ] - Customer Insights - Global ViewPFPCS-1370
[ ] - Customer Insights - Customer Products PortfolioPFPCS-1418

Tasks

[ ] - Manage Sonar bugs and code smells on Customer InsightsPFPCS-1075
[ ] - Update Product DM in QA partitionPFPCS-1113

https://pricefx.atlassian.net/browse/PFPCS-2564
https://pricefx.atlassian.net/browse/PFPCS-2742
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https://pricefx.atlassian.net/browse/PFPCS-2328
https://pricefx.atlassian.net/browse/PFPCS-2400
https://pricefx.atlassian.net/browse/PFPCS-2402
https://pricefx.atlassian.net/browse/PFPCS-2445
https://pricefx.atlassian.net/browse/PFPCS-16
https://pricefx.atlassian.net/browse/PFPCS-419
https://pricefx.atlassian.net/browse/PFPCS-689
https://pricefx.atlassian.net/browse/PFPCS-690
https://pricefx.atlassian.net/browse/PFPCS-1203
https://pricefx.atlassian.net/browse/PFPCS-1204
https://pricefx.atlassian.net/browse/PFPCS-1306
https://pricefx.atlassian.net/browse/PFPCS-1370
https://pricefx.atlassian.net/browse/PFPCS-1418
https://pricefx.atlassian.net/browse/PFPCS-1075
https://pricefx.atlassian.net/browse/PFPCS-1113
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[ ] - Update Sales standard data DS in QA partitionPFPCS-1117
[ ] - Trend symbolsPFPCS-1718
[ ] - Adjust [End date] for time filtersPFPCS-1743
[ ] - Upload new data in 2020PFPCS-1812
[ ] - Should check null value in operator of DashboardUtils element in Customer Detail ViewPFPCS-1837
[ ] - Create guideline how to configure Customer Insights DashboardPFPCS-2030
[ ] - Setup autopublishing for CID packagePFPCS-2365
[ ] - Create document for CIDs introductionPFPCS-2395
[ ] - [CID] Create deployment scriptPFPCS-2536
[ ] - [Portfolio] Pricing Opportunity by Worst Products should be hidden by defaultPFPCS-2539
[ ] - Fix release package-remove gitignorePFPCS-2558

Improvements

[ ] - Code Improvement from SonarPFPCS-1032
[ ] - Show customer Id, customer name under the title of embedded dashboardPFPCS-1067
[ ] - Double bar graph in embedded chartsPFPCS-1194
[ ] - Rename label "FieldName" to "Dimension Filter"PFPCS-1432
[ ] - Consistent Start and End Date for processingPFPCS-1451
[ ] - Consistent name for portlet header and chartPFPCS-1490
[ ] - Change configuration.RevenueFieldName to configuration.InvoicePriceFieldNamePFPCS-1509
[ ] - Display percentage for trend value L12MPFPCS-1518
[ ] - Move calculation for potential to Simulation logicPFPCS-1526
[ ] - Update logic to get Potential for Global View dashboardPFPCS-1527
[ ] - Refactor element "GetTopCustomers" of Customer Global viewPFPCS-1558
[ ] - Fix some sonar bugs in customer detail view dashboardPFPCS-1565
[ ] - Move some common inputs to libsPFPCS-1578
[ ] - Fix some sonar bugsPFPCS-1627
[ ] - Adding Unknown field to Cross Selling Opportunity table (Portfolio)PFPCS-1633
[ ] - Classes into Data Filter (Category)PFPCS-1683
[ ] - Product attributes input should get dimension attributesPFPCS-1726
[ ] - Rename "Buying Frequency" to "Number of transactions" in all dashboardPFPCS-1727
[ ] - Should set sortBy and list of attributes in function api.streamPFPCS-1731
[ ] - Formatting labelPFPCS-1805
[ ] - Update waterfall chart structure from AP settingPFPCS-1811
[ ] - Tooltips improvement - Revenue and margin trends & projections chartPFPCS-1842
[ ] - Change solution from memoryDB to non-memoryDBPFPCS-1847
[ ] - Correct value on Opportunity table of Portfolio dashboardPFPCS-1907
[ ] - Just show max 100% in axis of chartPFPCS-1916
[ ] - In Dimension filter, if change value of "Category" field, old value of "Value" field should PFPCS-1917
be reset to null/empty
[ ] - Hiding 0 value in table Potential by Product AttributePFPCS-1979
[ ] - Change arrow to fix problem on Unity and visible dashboard input items in portlet PFPCS-1992
selection
[ ] - Remove items as: ROWID and Scenario in Dimension Filter - CategoryPFPCS-2019
[ ] - Show "no data" in case no customer is selectedPFPCS-2020
[ ] - Customer Detail View - Customer Revenue and Margin Trend & Projection - Change PFPCS-2021
labels
[ ] - Global View - Pricing Opportunity: Change color for top/worst groupPFPCS-2022
[ ] - Customer Detail View - Number Of Transaction Trend & Projection - Change labelsPFPCS-2023
[ ] - Set display mode is 'Never' for some elements in Simulation logicPFPCS-2025
[ ] - Regression line should be a line in chartPFPCS-2042
[ ] - Improve performance of simulation logicPFPCS-2057
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https://pricefx.atlassian.net/browse/PFPCS-1451
https://pricefx.atlassian.net/browse/PFPCS-1490
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[ ] - Improve performance of customer product portfolio dashboardPFPCS-2058
[ ] - Improve performance of some elements in simulation logicPFPCS-2076
[ ] - Add Customer Segment to SimulationPFPCS-2221
[ ] - Customer Global View: Merge other metric process to SQL (in the same with X-sell/Up-PFPCS-2237
sell/RevenueBelowTarget
[ ] - Support multitype source to get customer segmentPFPCS-2264
[ ] - [Customer Product Portfolio] Update list value of Product attribute in Potential By PFPCS-2282
Product Attribute table match with Opportunity table
[ ] - [Customer Global View] Remove Sorted elementPFPCS-2286
[ ] - Update UI_Revenue and Margin Contribution chartPFPCS-2288
[ ] - [Customer Product Portfolio] Should use api.local to pass return value in element PFPCS-2305
"GetDataForPotentialPerProductAttribute"
[ ] - [Customer Product Portfolio] Update logic of element PFPCS-2318
GetTopAverageInvoicePriceByCustomerClassData to improve performance
[ ] - [Simulation] refactor simulation logicPFPCS-2456
[ ] - Change format number in charts and tablesPFPCS-2500
[ ] - Update label and default value of DataFilterPFPCS-2501
[ ] - [Customer Global View] Pricing Opportunity and Opportunity table - Just show the PFPCS-2502
WORST customers
[ ] - [Customer Detail View] View some value on click-through portletPFPCS-2503
[ ] - [Customer Detail View] Update regression value in chartsPFPCS-2508
[ ] - [Customer Detail View] - Customer Summary portlet- Adding more infoPFPCS-2512
[ ] - [Portfolio] – Revenue Below Target by Product Group chart – change name to Pricing PFPCS-2513
Opportunity by Product Group.
[ ] - [Global View and Portfolio] – the Health tables: all the Last 12 M and YTD trends will be PFPCS-2514
in removed from Health table and moved to a new table Trends.
[ ] - [Simulation] Customer Segment- adding separator in between the particular itemsPFPCS-2515
[ ] - [Portfolio] – rename "Revenue Below Target" to "Pricing Opportunity"PFPCS-2519
[ ] - [Customer Detail View] - Customer Summary portlet- Adding more infoPFPCS-2528
[ ] - Opportunity tables in Global and Portfolio – Please rename to Selling OpportunityPFPCS-2529

Sub-tasks

[ ] - Embedded Waterfall ChartPFPCS-672
[ ] - Embedded Breakdown Revenue ChartPFPCS-681
[ ] - Embedded Revenue and Margin ChartPFPCS-682
[ ] - Reporting hierarchy configurablePFPCS-693
[ ] - Customer health score CalculationPFPCS-694
[ ] - Buying Frequency CalculationPFPCS-695
[ ] - Create TDD4C for Embedded Waterfall ChartPFPCS-713
[ ] - Adding label to show the chosen Customer ID or Product Group in all ChartsPFPCS-824
[ ] - Cross Selling OpportunityPFPCS-887
[ ] - Adding Waterfall chart with percentage valuePFPCS-944
[ ] - Set up Simulation to run automaticallyPFPCS-1109
[ ] - Adding message to the chart when no data existPFPCS-1136
[ ] - Update attribute in PP Report Hierarchy to define the element we want to disablePFPCS-1137
[ ] - Comparing data between periodsPFPCS-1154
[ ] - Rename element and method to CustomerInsights instead of CustomerInsightPFPCS-1176
[ ] - Adding Volume trend into Customer Health ScorePFPCS-1189
[ ] - Add Pricing Opportunity table as old DBPFPCS-1374
[ ] - Apply Dashboard Library into this dashboardPFPCS-1375
[ ] - Add more item in time filter 'last 12 months' to compare with 12 months beforePFPCS-1389
[ ] - Apply Dashboard libs to existed chart in Customer Detail ViewPFPCS-1408
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[ ] - Add Revenue Breakdown to customer Detail ViewPFPCS-1409
[ ] - Add Waterfall Chart to customer Detail ViewPFPCS-1410
[ ] - Add Revenue and Margin per Quarter to Customer Detail ViewPFPCS-1411
[ ] - Add more 2 items in time filterPFPCS-1421
[ ] - Add Pricing Potential tablePFPCS-1422
[ ] - Update logic classification for customer base on new updatePFPCS-1425
[ ] - Refactor code for Customer Global View based on new structure data from Pre-ProcessPFPCS-1452
[ ] - Calculate Trend L12M based on dynamic monthsPFPCS-1463
[ ] - Update charts based on new changes of Highchart libsPFPCS-1475
[ ] - Add Cross Selling Opportunity TablePFPCS-1478
[ ] - Add Average Invoice Price tablePFPCS-1479
[ ] - Add Potential per product type TablePFPCS-1480
[ ] - Add Potential per product tablePFPCS-1481
[ ] - Add Bar & line chart showing PotentialPFPCS-1482
[ ] - Add Customer Dashboard Portfolio Dashboard InputsPFPCS-1483
[ ] - Add Pie chart showing sum of Potential and % of Total Potential per product typePFPCS-1535
[ ] - Set default value for List of Product Attribute is "Product Group"PFPCS-1588
[ ] - Add if statement bracesPFPCS-1628
[ ] - Add type for Constant in CustomerInsights.ConstantPFPCS-1629
[ ] - Revenue and Margin Contribution chartPFPCS-1699
[ ] - Update Calculation of Customer Health ScorePFPCS-1830
[ ] - Update calculation of Revenue/Margin/Volume trend last 12MPFPCS-1831
[ ] - Add calculation of Revenue, Margin and Volume trend YTDPFPCS-1832
[ ] - Update calculation of Cross-Sell Opportunity - Global ViewPFPCS-1833
[ ] - Update calculation of Revenue below targetPFPCS-1834
[ ] - Calculation for Cross-Sell Opportunity - Customer Product PortfolioPFPCS-1840
[ ] - Up-sell will be part of the Cross Selling Opportunity table which will be renamed to PFPCS-1846
Opportunity
[ ] - Change solution from memoryDB to non-memoryDB In Simulation logicPFPCS-1936
[ ] - Change solution from memoryDB to non-memoryDB In Customer Global View PFPCS-1937
Dashboard
[ ] - Change solution from memoryDB to non-memoryDB For Revenue Breakdown chart In PFPCS-1938
Customer DetailView Dashboard
[ ] - Add more CustomerId parameter for some functionsPFPCS-2284
[ ] - Change Revenue Below Target = Potential calculationPFPCS-2406
[ ] - Change % Revenue Below Target calculationPFPCS-2407
[ ] - Change Pricing Opportunity tablePFPCS-2408
[ ] - Add Product Health Score into SimulationPFPCS-2416

Change Requests

[ ] - Top/worst sorting not working properlyPFPCS-1685
[ ] - Add Margin to the Customer Revenue Trend and Projection chartPFPCS-1692
[ ] - Average Invoice price per the relevant customer into Average Invoice Price tablePFPCS-1693
[ ] - Merge Customer Health Score table with Customer Insight Summary tablePFPCS-1714
[ ] - Potential By Product table - new columns and renamePFPCS-1715
[ ] - Calculations updatesPFPCS-1778
[ ] - Linear trends & projections - seasonality adjustmentPFPCS-1781
[ ] - Update Cross Sell calculationPFPCS-2124
[ ] - [Customer Product Portfolio]- Rename Opportunity tablePFPCS-2326
[ ] - [Customer Product Portfolio] - Product Health Summary table - revert top/worstPFPCS-2327
[ ] - Update formulas for % Revenue Below TargetPFPCS-2401
[ ] - [Customer Product Portfolio]_Remove some Potential portletsPFPCS-2404
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[ ] - [Customer Product Portfolio]_ Change Pricing Opportunity table and Revenue below PFPCS-2405
target
[ ] - [Customer Global View]_ Change location click through “ to Product Portfolio"PFPCS-2424
[ ] - [Portfolio] Change "Potential" to "Revenue Below Target" for 2 charts: "Potential PFPCS-2429
Worst Products Chart" and "Potential Tops Products Chart"
[ ] - [Customer Global View]_ Change Revenue below targetPFPCS-2446
[ ] - [Customer Global View]_ remove fields in Pricing Opportunity tablePFPCS-2447
[ ] - [Customer Global View]_remove table Pricing PotentialPFPCS-2448

Bugs

[ ] - Customer Insight Summary: % Margin is not calculated exactlyPFPCS-796
[ ] - Error (@13) cannot get property "ProductMapCurrentime" on null object when Time PFPCS-806
Dimension = MTD or QTD
[ ] - Error (@74) occurs when choosing a single Customer IDPFPCS-808
[ ] - Incorrect cross-sell calculationPFPCS-829
[ ] - Customer ID does not display with revenue = 0PFPCS-834
[ ] - Export data in Unity UI does not keep filtering for countryPFPCS-835
[ ] - Buying frequency is incorrectPFPCS-865
[ ] - Margin trend last 12M is incorrectPFPCS-888
[ ] - Revenue trend last 12M is incorrectPFPCS-889
[ ] - Missing trend arrowPFPCS-901
[ ] - Error on clicking Customer ID has no dataPFPCS-902
[ ] - Error (@76) for PricingOpportunityAnalystPFPCS-1065
[ ] - Error(@0) for CustomerHealthScoreAnalystPFPCS-1066
[ ] - Incorrect Product Group in Cross Selling OpportunityPFPCS-1112
[ ] - Revenue and Margin % chart show wrong value and month formatPFPCS-1114
[ ] - Incorrect Price OpportunityPFPCS-1147
[ ] - Customer Health Score does not show with an input Customer IDPFPCS-1153
[ ] - Excel format is incorrect at fields have trending arrowPFPCS-1170
[ ] - Error (@0) when opening the dashboardPFPCS-1181
[ ] - Misspelled name in Waterfall chartPFPCS-1188
[ ] - Cross Sell Opportunity is not calculated (Global View)PFPCS-1423
[ ] - Counting for Customer classification (per Revenue) is incorrectPFPCS-1440
[ ] - Edit chart label (Global View)PFPCS-1484
[ ] - Error (@63) occurs when no data exists in Detail ViewPFPCS-1485
[ ] - Customer (s) filter does not work (Global View)PFPCS-1488
[ ] - Inconsistent name chart in Detail viewPFPCS-1519
[ ] - Trend charts display incorrect (Detail View)PFPCS-1547
[ ] - Category filter runs incorrect (Detail View)PFPCS-1549
[ ] - Incorrect calculation in Revenue Breakdown chartPFPCS-1570
[ ] - Error (@621) Ambiguous method overloading (Detail View)PFPCS-1589
[ ] - Local Adjustment does not show detail in waterfall chartPFPCS-1594
[ ] - Error when removing default or leaving blank in Time FilterPFPCS-1607
[ ] - Some fields in Cross Sell Opportunity table are incorrect (Product Portfolio)PFPCS-1622
[ ] - Check Zero when calculation AvgPrice in function Classification.calculateAvgPricePFPCS-1678
[ ] - Should check null in some functions of CustomerInsights libsPFPCS-1725
[ ] - Ranking is incorrect by KPI = Health Score (Global view)PFPCS-1744
[ ] - Filter MTD and QTD do not work in Product Portfolio DBPFPCS-1818
[ ] - [Product Portfolio]_ Product Trend YTD is incorrect when no customer selectedPFPCS-1946
[ ] - Global View_Customer input should not affect to calculationPFPCS-1998
[ ] - Average Revenue segment should be calculated on Customer RevenuePFPCS-2002
[ ] - % Product Buying_ total of traded products should be changed by Category filterPFPCS-2009
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[ ] - Customer Product Portfolio dashboard - chart "Revenue And Margin Contribution" PFPCS-2247
show null in drilldown
[ ] - Portfolio_Cross Sell only shows for products bought (not bought is not shown)PFPCS-2271
[ ] - [Customer Product Portfolio] There is an error as attached picturePFPCS-2287
[ ] - Health score should get decimal or roundingPFPCS-2439
[ ] - [Portfolio] doesn't show "Revenue Below Target By Product Type" chart for some casePFPCS-2458
[ ] - [Customer Global View] Pricing Opportunity table, if the Revenue below Target = 0 PFPCS-2461
then % Revenue below Target should be 0%.
[ ] - [Portfolio] Update formulas for Average Invoice Price = Average Unit Invoice Price for PFPCS-2467
the particular Product ID and particular Customer Segment
[ ] - [Global View]_ % Product Buying is incorrectPFPCS-2489
[ ] - [Portfolio]_Top/Worst Products in chart should be ranked like Top/Worst Customers in PFPCS-2492
Global View
[ ] - [Detail View] _Remove "per Day" in chart for Transactions trend last 12MPFPCS-2521
[ ] - Trend arrow displays incorrectlyPFPCS-2530
[ ] - [Detail View]_Error (@282) when no data to displayPFPCS-2565
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